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Introduction 
 
 
About Yardi Voyager Residential 

 
With Yardi Voyager Residential, you can manage prospects, applicants, and residents at multi-family 
residential properties. This manual includes information specific to Residential Plug-in 1.2 for 
Yardi Voyager version 70.8. 

 
 

Notes 
 
 

 
 
 

 
 
 

 
 
 

Help 

 
 
An information note provides background information. For example, it may explain how changes 
made in one screen affect data that appears in another screen. 
 
 
A caution note explains how to avoid a potential problem, or indicates that a process will cause 
irreversible changes to your data. 
 
 
A tip describes a way to get more from your software. For example, it may explain an alternative way to 
perform a task. 

 

Most Voyager screens have a Help button for quick access to information about using the screen. 
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Yardi Voyager Interface 
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This chapter provides information on how to effectively use the Yardi Voyager user interface. The 
Voyager Web interface is composed of standard Web-based program elements including menus, 
toolbars, buttons, data screens, and fields. 
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Voyager Online Help 
 

Most Voyager screens have a Help button, which allows you to access information about the screen 
and the procedure, which use it. 

 
 
 

Help button 
 

When you click the Help button, the Help system opens in a separate window. 
 
 

 
To close the Help window, click the X button in the top right corner. 
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Logging in to Voyager 
 
 

In this section: 
 

Using the Internet Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4 
Basic Voyager Screen Elements . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5 
Using the Top Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6 

 
 

To log in to Voyager 
 

1   Open a web browser. 
 
2  Type the Voyager Web address (https://yardiaspla5.com/95566cambridge/pages/InvalidLogin.aspx) 

into the Address field of the browser. 

 
 

The Voyager Login screen opens. 
 
 

For help with your login, contact your Yardi Support Team at yardisupport@cresapts.com.  
 

3   Complete the following fields: 
 
 

User Name Type the user name, first letter of your first name followed by your last name.  All lower 
case with no spaces - Example: jdoe 

 
Password Type the password provided by your system administrator. 

 
 

Database Select the LIVE database 
 
 
 

4   Click Submit. A dashboard screen opens. A typical user would see either the Community 
Manager Dashboard or the Leasing Consultant Dashboard. 

 
The dashboard you see is determined by your user settings, which are established by your 
system administrator. 
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The Community Manager Dashboard is shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using the Internet Browser 
 

Voyager always appears in a browser window. The following diagram and table show Microsoft 
Internet Explorer browser features that are pertinent to using Voyager. The same features are 
available in other browsers, but might appear in other places. 

 
Forward button 

 
 

Back button 
File menu 

 
 

Print button 
 
 

File menu Specifies printing options from Page Setup (File > Page Setup) and Print (File > Print) 
dialog boxes. 

 
Back button Displays the previous program screen. 

 
Forward button Displays the program screen ahead of the one you are viewing. This button is active 

only if you have already backed up at least one screen. 
 

Print button Prints the current browser screen. See the File menu for more printing options. 
 
 

A Web-based screen is only a snapshot of the most current program operation. If you perform a 
program task and then click the browser’s Back button, you might go back to an old screen that has 
not been updated. The same warning applies to the Forward button. 
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Basic Voyager Screen Elements 

 
The following diagram and table show some basic Voyager screen elements. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Side menu Provides access to menu selections for performing tasks in Voyager. 
 

Menu Search Used to quickly find a menu item. Enter a word, phrase, or partial word in the search 
box, and 

Voyager immediately returns the matching menu items. 
 

Top menu Provides access to menu selections for performing frequent tasks in Voyager. 
 

Fly Out menu Provides access to specific tasks within a category. 
 

Favorites Displays a list of menu items that you have designated as “favorites.” Select an 
item to open the corresponding screen. 

 
Site Search Used to quickly find Voyager records. 

 
Search Results Displays search results performed in the current session. 

 
History Displays a list of the menu items selected in the current session. Click on an item to 

return to that screen. 

History Favorites Menu Search 
Help 
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Using the Top Menu 

 

The top menu provides access to frequently used tasks in Voyager, as well as links to the home and sys- 
tem home menus. The top menu items can vary depending on what module and dashboard you 
are using, although the Home, Filter, and Log Out links are always available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Here are descriptions of some of the common links: 
 
 

Roles Allows you to switch between dashboard views (for example, between the 
Community Manager dashboard and the Affordable Manager dashboard). This 
item only appears if your security settings allow you to view more than one 
dashboard or menu set. 

 
Home Returns you to your module’s home page. For example, if you are in a data screen in the  

Manager module, click this link to return to the Community Manager home page. 
 

Help                            When you click the Help button, the Help system opens in a separate window. 
 

 
Log Out Logs you out of your database. The logged out screen appears. You can log in 

again to the same database or a different one by clicking the link. 
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Side Menu (Main Menu) 
 

Using the side menu, you can access most of the functions in Voyager. The side menu has two (and 
sometimes three) levels. Click on a top-level item to open the second level. Move your cursor 
over a second-level item and a third level opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Top level Second level Third level 
 
 

In this manual, we describe menu selections in this manner: Select (Top Level) > (Second Level) > 
(Third level). For example: Select Residents > Move-In Functions > Move In. 

 
 

Menu Search 
 

The menu search feature allows you to quickly find a menu item. Enter a word, phrase, or partial 
word in the search box, and Voyager immediately returns the matching menu items. 

 
 
 

Menu Search 
 
 
 
 
 
 
 
 
 

In the example above, we entered the word “straight” and Voyager returned all the menu items related 
to straight-lining. 
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When you click the desired menu item, Voyager opens the corresponding screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Favorites 
 

When you click the Favorites icon, Voyager displays a list of menu items that you have designated as 
“favorites.” Select an item to open the corresponding screen. 

 
Favorites icon 

 
 
 
 
 

Favorites menu 
 
 
 

Adding and Deleting Items on the Favorites Menu 
 

To add an item to the Favorites menu, locate it on the side menu, and right-click. The Add to 
Favorites box appears. Select it. 

 

 
 

Right-click and select Add to Favorites 
 
 
 

To delete an item from the Favorites menu, right-click it and select Delete. 
 
 
 
 
 
 

Right-click and select Delete 
 
 
 

The Favorites menu is linked to the user and the current menu set. Each user can build and maintain a 
favorites menu for each Voyager module he/she uses. 
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History 
 

When you click the History icon, Voyager displays a list of the menu items selected in the current ses- 
sion. Click on an item to return to that screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

The History feature only tracks items selected from the menu, not links from the dashboard. This is by 
design. 

 
 
 

Filter Screens 
 

Filter screens enable you to find existing data records. For example, if you are looking for a 
resident record, you select Resident > Find Resident, and a filter screen appears. 
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In the filter, you enter search criteria. When you click Submit, Voyager displays a list of residents that 
match your criteria (the search results) and the first record in the list. 

 
First record in the list Search results 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Many filters have no required fields. In some cases, it makes sense to leave a filter blank and click 
Submit. The system displays all the records of that type on the left, and you can select which 
records you want to see. 

 

Other filter screens are used for functions. For example, if you select Resident > Resident Rent 
Increase, a filter appears where you specify details of the rent increase. 

 
The following is an example of a filter screen and some of its features: 

 
Mandatory field 

 
 
 
 
 
 
 
 

Pop-up link 
 
 
 
 

Date field 
 
 

Drop-down list 
 
 
 
 
 

Drop-down list Displays a list of options to choose from. You can only choose one item from the list 
at a time. 

 
Pop-up link Opens a look-up list to search for codes that you want to review. 

 
Mandatory field Fields highlighted in blue are required and must be completed before you can 
proceed. 

 
Date field Click the calendar icon to choose a specific date to complete the Date field. 
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Filter Search Results 
 

When you use a filter to search, the results appear in a box in the main screen (they no longer appear 
on the side menu). 

 
Filter Search Results box Search Results icon 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can minimize the results by clicking the Search Results Icon. The box disappears. The search 
results persist, and you can bring them back by clicking the icon again. 

 
 

Multiple Searches 
 

If you search for another item, the search results box retains the original search results and displays a 
new tab for the second search. 

 
Tab for old 
results 

Tab for new results 
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A third search will result in a third tab, and so on. 

 
 
 
 
 
 
 
 
 
 
 

To close a tab, click the “X” to the right of the name. 
 
 

Refresh Button in Search Results 
 

The Search Results box contains a Refresh button that will rerun the original search. 
 
 
 
 

Refresh button 
 
 
 
 
 
 

In the example shown above, we searched for the “1101” unit record. There were no results, 
because the record had been given the wrong code. We then located the record and changed the 
code. 

 
 
 
 
 
 

Search results after refresh 
 
 
 

Later on, we wanted to access the record. Instead of repeating the search, we just clicked the Refresh 
button in the Search Results box, and the record appeared on the screen. 
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Using Look-up Lists (Pop-up Links) 
 

The pop-up link opens a new window that displays the codes you need to complete a particular field. 
 
 

Search field 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you do not immediately know the codes you need, type the first characters of the codes or the 
descriptions in the Search field. Click Find to display the results of your search. When you find the 
codes of your choice, select the codes you want and click OK. The field on the filter screen is 
completed with the codes you selected. 

 
For efficiency, you can search for codes using a wildcard search. A wildcard allows you to use a symbol, 
in this case the percentage sign (%), as a substitute for certain characters in a code. Here are a 
couple of ways to demonstrate the wildcard search, using the Property pop-up list as an example: 

 

!    pa 
 

If you are looking for all properties that begin with the letters pa, include the percentage sign after 
pa. Click Find and the pop-up list displays those properties for that search. 

 
!    palm 

 
If you are looking for all properties that contain the word palm, enclose the word in percentage signs. 
Click Find and the pop-up list displays those properties for that search. 

 
When you type the code of your choice, you will find a description of that code to the right of the field 
on the filter screen. This description will help you identify the code that you are using. The 
following is an example of a property code description. 

 
Code description 
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Using the Drop-down List 
 

The drop-down list provides a list of options to choose from. When you click the down arrow, the list of 
options appears. The following is an example of the Status drop-down list: 

 
 
 
 

Drop-down list 
 
 
 
Using the Date Fields 

 
If you need to complete a Date field, the calendar icon comes in handy. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Calendar 
icon 

 
 
 
 
 
 
 

When you click the calendar icon, a calendar opens showing the current month and year. The 
current date is highlighted. 

 
 
 
 
 
 

Current date 
 
 
 

You can search through the months and years to find the date you need. Single arrows (< , >) move 
the calendar one month forward or back. When you locate the appropriate date, click it to select it. The 
calendar closes and the date field is filled in. 
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Understanding Data Screens 
 
 

In this section: 
 

Using the Jump To field . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16 
Using the Search Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16 
Using the Functions Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16 
Using the Command Buttons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16 

 
 

Data screens store property management information, ranging from prospect, applicant, and 
resident records to transaction records. Data screens are set up with the record navigation list on the 
left side of the screen and the first record in the list displaying on the right side of the screen. You can 
choose the records you want to review or update by finding the records through the navigation list 
on the left. The following is an example of the Resident screen: 

 
Functions menu Jump To 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Command 
buttons 

Search box 

 
 

Functions menu Provides links to common functions that apply to the record type. 
 

Jump To Finds another record of the same type. 
 

Command buttons The basic buttons used throughout data screens: New, Save, Delete, Cancel, and Help. 
 

Search box Shows all or chosen records for the screen that you are on. 
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Using the Jump To field 

 
The Jump To field is located on the upper right hand corner of the screen. If you need to find another 
record of the same type, the Jump To field can locate the record quickly. From any data screen, 
type the code you want to view and press the TAB key on your keyboard. The record displays on 
the right side of the screen. You can only view one record at a time. 

 
Using the Search Box 

 
By default, the Search box appears on the right side of the screen. This box shows the available or 
chosen items for that data screen. Use the scroll bar and navigation buttons to browse through all 
the items on the Search box. 

 

Click an item in the Search box to select it. It is displayed to the left of the Search box. 
 
 

Using the Functions Menu 
 

The Functions menu appears on many of the data screens and provides links to common 
functions that apply to the record type. The specific functions that appear are related to the status of 
the record. For example, if a resident’s status is future, the Move In function appears on the menu. 
For a current resident, the Notice function appears. 

 
Using the Command Buttons 

 
The Command buttons provide the common functions to proceed in a screen. Examples are New, 
Save, Delete,  Cancel,  and Help. 



 17 
 

Automatic Field Formatting 
 

Throughout Voyager, there are several formatting conventions that the program applies to data you 
type on the screen. For your convenience, Voyager converts the information appropriately. 

 
 

Date For date fields, you do not need to type a forward slash (/) or dash (-) to complete the 
date. Use the following formats as they apply to the date field: mmddyy, mmddyyyy, 
mmyy, or mmyyyy. 

 
Dollar sign For any fields that require dollar amounts, you do not need to type a dollar sign ($). 

 
Email                           For any fields where you can include an email address, the program creates an active 

link so that you can send an email message if necessary. This does not apply to the 
Reports menu. Type the email address in its entirety, and the program makes the 
link active (underlined, blue). 

 
Percent sign (%) For any fields that require a percentage amount, you do not need to type a percent 
sign (%). 

 
Telephone number For any fields that require a telephone number, you do not need to include 

parentheses () around the area code or a dash (-) between digits. 
 

Time For any fields where you need to type the time, you do not need to include the 
colon (:). The program formats the time appropriately. However, you do need to 
type “AM” or “PM” after the numbers, for example, “900 AM.” 

 
 
 

Site Search 
 

The Site Search feature allows you to quickly find Voyager records. 
 

 
Site Search 

 
 
 
 
 

You can search all records, or you can narrow your search to single record type. 
 
 

Using a Search Code 
 

In the following example, we were looking for a vendor record that started with “lum.” We entered 
the search code for vendors, “V,” followed by a colon and “lum.” 

 
Search string 

 
 

Search results 
 
 
 
 
 
 
 
 

The search returned only vendor records. 
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Searching Without a Search Code 

 

If you search without a search code, Voyager looks at all the records in the database. In the 
following example, we entered “que” and Voyager returned all the matching records: properties, 
property lists, leases, and owners. 

 
Search string 

 
 

Search results 
 
 
 
 
 
 
 
 
 

Each record type appears in a separate tab. 
 
 

Search Codes and Columns Searched 
 

The following table gives the search codes for each record type. It also lists the database fields that 
are searched for each record type. 

 

Record Type 
 

Search Code Table Columns Searched 
 

Job 
 

Job 
 

Code, Description, Site Address, Site City, Site ZIP 

Mortgage AP Mort Code, Description 

Commercial Deal CommDeal Code, Description 
 

Memo 
 

Memo 
 

Description 

Bank Bank Code, Description 

Tenant Resident Code, Last Name, Address 1, Address 2, City, State, ZIP 
Code 
 

 

Owner 
 

O 
 

Code, Last Name, Reg. No 

DCF Analysis Dcf Code, Description 

Unit U Code 

Charge type ChargeType Code, Description 

Contract Contract Code, Description 

Vendor V Code, Description 

Account Acct Code, Description 

Property P Code, Address 1, Address 2, Address 3, City, State, ZIP 
Code 
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Record Type Search Code Table Columns Searched 

Fund_data Fund Code, Name 

Customer Customer Code, Name 

Contact Contact Code, Description, Company Name, Last Name, First 
Name, Email, Address 1, Address 2, City, ZIP Code 

 

 

Hot Keys 
 

You can now create keyboard combinations for menu items. For example, if you frequently need to 
review customer records, you could create a keyboard combination for the Review Customer screen. 

 

 
To add a hotkey 

 

1   Select the menu path (for example, Lease Administration  > Customers > Review Customers). 
 

2   Right-click the last item in the path. A box appears below the menu item. 
 
 
 
 

Add Hotkey 
 
 

3   Select Add Hotkey.  A window appears. 
 
 
 
 
 
 
 
 
 
 

4   Add a keyboard combination by holding down the ALT key and typing a letter. 
 

5   Click the Assign Hot Key button. 
 

If there is a conflict with an existing keyboard combination, an error message will appear, and you 
can select another combination. 

 

Once the hot key has been created, you can use it instead of selecting the menu item. 
 
 

Default Hot Keys 
 

Two global keyboard combinations are included as defaults: 
 
 

Alt+R Closes the Search Results window (or re-opens it, if it is already closed). 
 

Alt+M Collapses the side menu (or expands it, if it is already collapsed). 
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CHAPTE R 2 
 
 
 
 

Leasing Workflow 
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This chapter contains a description of each step in the leasing workflow. It also contains procedures for 
the following: 

 

!    Searching for a guest record and restarting the workflow 
 
!    Recording contacts with guests 



 21 
 

Introduction to the Leasing Workflow 
 

The leasing workflow in Voyager is a series of steps that occur, as a prospect becomes a resident. The 
steps go from gathering basic contact information on the phone to approving an application and 
signing a lease. 

 
Each step is explained in the diagram below. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

There is a Voyager screen for each step. As you complete one step, Voyager moves you automatically 
to the next. If you stop the process and restart it later, Voyager opens the step where you left off. 
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Voyager also shows you where you are in the process—each screen contains a list of the steps with the 
current step highlighted. 

 
 
 

Leasing Steps 
(with current 
step highlighted) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Adding a Guest Card 
 

You begin the leasing workflow by entering the guest’s name and basic contact information. 
 

1   On the dashboard, verify that the appropriate property is selected. 
 

2   Click the Add Guest link. 
 

Add Guest link Selected property 



 23 
 

The Prospect Guest Card screen appears (with the Property field already completed). The required 
fields are highlighted in blue. 

 
 
 
 

Guest Card 
(current step) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   Enter the guest’s first and last name. 
 

4   Complete the following fields: 
 
 

First Contact Select the type of contact (for example, call, walk-in, or email). 
 

Agent Select your name. 
 

Source Select how the guest learned about the community (for example, newspaper ad or 
referral). 

 
Date Voyager uses today’s date as a default. Change it if necessary. 

 
 

5   Enter any contact information you obtain from the guest (address, phone number, and so on). 
 

6   Complete the Notes field as applicable. 
 

7   Click Next to save the record and move to the next step. The Preferences screen appears. 
 

8   To exit the workflow, click the Home link in the top menu. 
 

Home link 
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The dashboard appears. The Prospect Pipeline count is increased by one. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

    Prospect Pipeline count 
 
 

Locating a Guest Record and Returning to the Leasing 
Workflow 

 
 

In this section: 
 

Clicking the Prospect Pipeline Count . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . 25 
Searching for a Guest by Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26 

 
 

You can stop and start the workflow at any time. There are two ways to restart the leasing workflow: 
 
!    Clicking the Prospect Pipeline count 

 
!    Searching for the guest by name 

 
The Prospect Pipeline count represents recent guests (all guests who have been added in the last 30 
days). If you need to locate a guest record that is older than 30 days, you can search for the guest by 
name. 
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Clicking the Prospect Pipeline Count 

 
 

To click the prospect pipeline count 
 

1   Click the Prospect Pipeline count (shown above). The screen displays all the guests in the pipeline. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Name link 
 

2   Click the name link to open the Guest screen for that person. Voyager displays the appropriate step 
in the leasing workflow. 
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Searching for a Guest by Name 
 
 

To search for a guest by name 
 

1   On the dashboard, click the Person Search tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Person 
Search tab 

 

Name field 
 
 
 
 
 
 

Name link 
 

2   In the Name field, type the first or last name of the person you want to look up. 
 

You can search by other criteria as well: phone number, email address, and so on. 
 

3   Click Search. The right half of the screen displays the names of all guests or residents with that 
name. 

 

4   Click the name link to open the Guest screen for that person. Voyager displays the appropriate step 
in the leasing workflow. 
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Preferences 
 

In this step, you enter information about the type of apartment the guest is looking for. 
 
 
 
 
 

Preferences 
(current step) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To complete the Preferences step 
 

1   Complete the required fields: 
 
 

Expected Move-In Type the date the guest wants to move in. 
 

Bedrooms Type the number of bedrooms the guest is looking for. 
 
 

2   Complete the Desired Rent field, if applicable. 
 

3   Check off any Amenity Preferences that apply. 
 

Amenity options vary by property. 
 
 
 

4   Click Next to save changes and move to the next step. The Occupants tab appears at the 
bottom of the screen. 
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Occupants 
 

In this step, you enter information about people who will share the apartment with the guest, or 
people who will co-sign the lease for the guest. 

 
 
 
 
 
 

Occupants 
(current step) 

 
 
 
 
 
 
 
 
 
 
 

Add occupant link 
 
 

This step is optional—if there are no occupants, click Next to move to the next step in the workflow. 
 
 
 

To complete the Occupants step 
 

1   Click the Add New Occupant link. The Occupant screen appears. 
 
 
 
 
 
 
 
 
 

Lessee 
checkbox 

 

 
 
 
 
 
 
 
 
 
 

2   Complete the required fields: First Name and Last Name. 
 

3   Enter any additional information (address, phone number, and so on). 
 

4   If the occupant will be a lease holder, verify that the Lessee checkbox is selected. 
 

If the occupant will not be a lease holder, clear the Lessee checkbox. 
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5   Click Save. The occupant’s name appears on the Prospect Guest Card screen. 
 
 
 
 

Edit link 
 

 
Occupant’s name 

 
6   To add another occupant, click the Add New Occupant link. 

 
7   To edit the information for an occupant, click the Edit link. 

 
8   Click Next to continue the leasing workflow. The Select Unit screen appears. 



30! YARDI!VOYAGER!RESIDENTIAL!PROCEDURES!GUIDE!
 
 

Select Unit 
 
 

In this section: 
 

Showing a Vacant Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31 
Showing the Model Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33 
Putting a Guest on a Waitlist . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34 
Changing the Unit Selection Criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35 
Holding a Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . . . . 35 
Releasing a Hold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37 
Printing a Brochure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .37 
Viewing Specials for a Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . 39 
Selecting a Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40 

 
 

The Select Unit screen shows all the currently available units that match the bedroom choices defined 
on the Preferences screen. 

 
 
 
 
 
 
 

Select Unit 
(current step) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Show link 
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You can use the Select Unit screen to: 
 
!    show a vacant unit 

 
!    show a model unit 

 
!    put the guest on a waitlist 

 
!    hold a unit 

 
!    release a hold 

 
!    change the unit selection criteria and view a different set of units 

 
!    print a brochure 

 
!    view specials for a unit 

 
!    select a unit for the guest 

 
 

Showing a Vacant Unit 
 

Use the Show function to schedule an appointment to show a unit to a guest. ( You can also use it to 
record that you have shown a unit to a guest.) 

 
 

To show a vacant unit 
 

1   In the table of available units, locate the unit you want to show to the guest. 
 

2   Click the Show link. The Contact screen opens. 
 
 
 
 
 
 
 
 

Clock icon 
 
 
 
 
 
 
 
 
 
 

Voyager fills in most of the fields for you:  Type, Agent,  Date, Property,  and Unit. 
 

3   Verify the information on the screen (Agent, Property, and Unit). 
 

4   The Date field defaults to today’s date. Change it to the day of the showing (if the showing is 
not today). 
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5   Click the Clock icon. In the pop-up, select the time of the appointment. 
 

6   Click Save. Voyager saves the appointment. 
 
 

Results 
 

In the Traffic section of the dashboard, the count for Today’s Showings is increased by one (on 
the day that you have scheduled the appointment). 

 

If you click the number, you can view details on the appointments. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Calendar 
tab 

 
 
 
 
 

Details on showings Count for today’s 
showings 

 
The scheduled showing also appears on the calendar. (Click the Calendar tab to view the calendar.) 

 

 
 
 
 
 
 
 
 

Scheduled showing 
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Showing the Model Unit 

 
In this procedure, you change the selection criteria to view model units and schedule an appointment 
to show a model unit to a guest. 

 

 
To show the model unit 

 

1   Select the Show MODEL units only check box. 
 
 
 
 
 
 

Show MODEL units only check box 
 
 
 

2   Click the Refresh button. The unit table displays model units. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Show link 
 

3   Click the Show link for the appropriate model unit. 
 

4   The Contact screen opens. 
 
 
 
 
 
 
 
 

Clock icon 
 
 
 
 
 
 
 
 
 
 

Voyager fills in most of the fields for you: Type, Agent, Date, Property, and Unit. 
 

5   Verify the information on the screen (Agent, Property, and Unit). 
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6   The Date field defaults to today’s date. Change it to the day of the showing (if the showing is not 
today). 

 

7   Click the Clock icon. In the pop-up, select the time of the appointment. 
 

8   Click Save. Voyager saves the appointment. 
 
 

Putting a Guest on a Waitlist 
 

If the property has been set up with a waitlist unit, you can put a guest on a waitlist. 
 
 

To put a guest on a waitlist 
 

1   Select the Show Wait units only checkbox. 
 
 
 
 
 

Show WAIT units only check box 
 
 
 
 

2   Click the Refresh button. The unit table displays waitlist units. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Select link 
 

3   Click the Select link for the appropriate waitlist unit. The screen refreshes. The top of the Prospect 
Guest Card screen shows that the guest has been assigned to the waitlist unit. 

 
 
 
 
 
 

Assigned unit 
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Follow-Up 
 

After assigning a guest to a waitlist unit, you can: 
 
!    leave the guest at the Select Unit step until a unit is available, or 

 
!    move the guest through the application steps, and change their unit assignment later. Click the 

Next button to move to the next step: Rental Options. 
 
 

Changing the Unit Selection Criteria 
 

You can change the unit selection criteria to look at units with different bedroom sizes. 
 
 

To change the unit selection criteria 
 

1   Clear the Bedrooms check box. 
 
 
 

Bedrooms check box 
 
 
 
 
 
 
 
 
 
 

2   Click the Refresh button. The screen displays all the available units (of any bedroom size). 
 

You can also uncheck the property checkbox to see available units for other properties (that you 
have security access to see). 

 
Holding a Unit 

 
With Voyager, you can hold an available unit for a prospect. This makes the unit unavailable for other 
prospects for the length of the hold period. 

 
 



36! YARDI!VOYAGER!RESIDENTIAL!PROCEDURES!GUIDE!
 
 

To hold a unit 
 

1   Locate the appropriate unit and click the Hold link. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hold link 
 

2   The Hold screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   Verify the Hold Until date or type in a new Hold Until date. 
 

4   Click Hold. 
 

A confirmation message appears: Do you wish to hold this Unit? 
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5   Click OK. 
 

The Select Unit screen shows that the unit has a hold on it. 
 
 
 
 
 
 
 
 

When you search for units for other guests, the held unit appears on the Select Unit table, but the 
Select link and the Hold link are unavailable (grayed out). The links are unavailable until the Hold 
Until date occurs or the hold is released. 

 
Releasing a Hold 

 
 

To release a hold 
 

1   Use the Person Search tab (in the Dashboard)  to locate the guest. 
 

2   Click the Name link. The Guest Card screen opens at the Select Unit step. 
 

3   Click Release. You can now select the unit, if appropriate. 
 

You can also click the On-Hold Units count on the dashboard. The dashboard displays a list of 
held units. You can release the hold or adjust the Hold Until date from there. 

 
Printing a Brochure 

 
If the property has been set up for brochures, you can print a brochure on a unit from the Select Unit 
screen. 

 

 
To print a brochure 

 

1   Locate the appropriate unit (in the table of available units). 
 

2   Click the Brochure link. 
 
 
 
 
 
 
 
 
 

Brochure 
link 
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The brochure opens in a separate window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   To print the brochure, right click on the brochure and select Print. 
 

4   To email the letter, enter an email address and click the Email button. 
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Viewing Specials for a Unit 

 
 

To view specials for a unit 
 

1   Locate the appropriate unit (in the table of available units). 
 

2   Click the Specials link. 
 
 
 
 
 
 
 
 
 

Specials 
link 

 
The specials appear in a separate window. 
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Selecting a Unit 

 
 

To select a unit 
 

1   Locate the appropriate unit and click the Select link. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select link 
 

The screen refreshes. The top of the screen shows the selected unit. 
 
 
 
 
 
 

Selected unit 
 
 
 
 
 

2   Click Next to move to the next step in the leasing workflow. The Rental Options screen appears. 
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Rental Options 
Use the Rental Options screen to review lease dates and to add rentable items to the lease. 

You can also generate a quote letter from this screen. 
 
 
 
 
 
 
 
 

Select Unit 
(current step) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

S 
To complete the Rental Options step 

 

1   Verify the Expected Move-In date. Change it if necessary. 
 

2   Verify the Lease-From Date. The Lease-From Date is the start of the lease (when the resident will 
begin paying rent). This date may vary from the Expected Move-In date. 

 

3   Verify the Lease Term (in months). This field shows the default lease term for the property. Change 
it if necessary. 

 

4   The Lease To Date is completed by Voyager when you press the TAB key. 
 

 
To determine the number of other leases that will expire near the end date of this lease, click the 
Lease expiration count link located under the Lease-To Date field. 
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5   Select any rentable items that you want to add. 
 

Click the Reserve button. The Rentable Item Reservation screen appears. 
 

Select the Reserve checkbox in the row corresponding to any rentable items that you want to add. 
 
 
 
 
 
 

Reserve check box 
 
 
 
 

Click Save. The screen closes. Voyager calculates the charges and updates the Rentable Items and 
Options table. 

 
 
 
 
 
 
 
 

6   The Unit Rent and Deposit fields are filled in by Voyager, based on the unit type. You can 
change the Quoted Rent field, if necessary. 

 

7   Click Next to save changes and move to the next step. The Concessions screen appears. 
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Generating a Quote Letter 
 
 

To generate a quote letter 
 

1   Click the Quote button. The letter appears in a separate window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   To print the letter, click the Print button. 
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Concessions 
 

The Concessions screen displays any concessions that have been set up for the unit. 
 
 
 
 
 
 
 
 
 

Concessions 
(current step) 

 
 
 
 
 
 
 
 
 
 
 
 
 

Total maximum allowable concession 
 
 

This step is optional. To skip it, click the Next button. 
 
 
 

To complete the Concessions step –See Chapter 4 for more details regarding L e a s i n g  S p e c i a l s  
 

1   To select a concession, click the Select check box. 
 

If the property is configured for revenue management with Rainmaker LRO, the total amount in 
concessions that you can select cannot be greater than the total amount next to the Total 
maximum allowable concession field in the LRO Concessions section. 

 
2   Type the amount of the concession, if applicable. (In some cases you are not able to modify 

the amount.) 
 

3   Type a number for the Starting Month.  (“1” corresponds to the first month of the lease; “2” 
means the second month, and so on.) 

 

4   In the Duration field, type the number of months the concession should last. 
 

5   Click Next to save the data and move to the next step. The Application Form screen appears. 
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Application Form 
 

The Application Form screen displays the guest’s name and any additional occupants. 
 

1. Print an application from Tenant Technologies website, make sure each adult applying for 
the unit fills one out. 

2. Collect the application fee(s).  
3. Fax completed application(s) to Background Investigations.  

 
 
 
 
 
 
 
 
 
 

Application 
Form 
(current step) 

 
 
 
 
 
 
 
 
 

This section you will learn how to identify a potential applicant and how to properly process an 
application. As detailed, after you have determined that your applicant is eligible to apply, you’ll 
submit the Rental Application to the screening company. Once the screening company has verified 
the information, they’ll respond with either an approval or a denial. If approved, you’ll receive a list of 
guidelines that need to be followed to qualify your applicant. 
 

Rental Application Process 
 

Application Packets 
 
Application packets should always be on hand to provide to prospects. To have them ready when 
needed for distribution to prospective residents, packets can be assembled ahead of time and 
typically contains: 
 

• Manager, Assistant Manager or Leasing Agent business card 
• Rental Application  
• Criteria for Residency 
• It should include a brochure and apartment floor plan flyer 
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Eligibility For Renting 
 
Each application must be prepared with attention to the individual. This includes first-time renters, 
minors, dependent adults enrolled in school, and dependent adults under the care of the primary 
applicant, and all others who may influence the application process. Listed below are guidelines that 
need to be followed to ensure that the proper procedure is followed: 
 

• First-time renters may require a co-signer (see the Co-signer Agreement form). 
• Dependent adults (disabled, elderly) under the care of the primary applicant are required to 

sign the rental agreement, unless a waiver is granted by the Property Supervisor. 
• Dependent adults (college students) may be required to sign the Rental Agreement. 
• Live-in caregivers are not required to sign the Rental Agreement, but the live-in and the 

resident are required to sign the Live-In Care Attendant Affidavit. 
• Minors that are: parents, married, emancipated, or pregnant are required to sign the rental 

agreement. 
 

Application Processing 
 
Anyone interested in applying for an apartment will go through the application process. Key tips to 
remember include: 
 

• Each adult member of household, regardless of marital status, must complete a separate 
application and pay a separate screening fee. 

• Confirm the applicant has read and understands the criteria for residency. 
• Have each applicant submit a legible, complete, and accurate application; make sure it is 

signed. 
• Carefully review the application for completeness and accuracy and collect the screening fee. 
• Verify the applicant’s photo identification. 
• Provide the applicant with a copy of the signed application. 
• If the household contains more than one applicant, submit all applications to the screening 

company at once. 
 
OREGON PROPERTIES ONLY: 
 
All new applicants must receive a completed Supplement of Application Form. This form provides 
the applicant with a list of all applicable deposits and charge.
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To complete the Application Form step 
 

1   Click the Application Information link for the guest. The application form appears in a 
separate window.    

2   Enter the applicant/occupant’s Social Security Number in the required field.  If the 
applicant has not provided a Social Security Number, enter 000-00-0000.  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The application contains any information that was already entered on the guest card. 
 
 

3   If applicable, click the Occupant Information link for any additional occupants and repeat 
steps 1–3. 

 

4   Click Next to save the data and move to the next step. The Application Charges screen appears. 
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Application Charges 
 

The Application Charges screen displays the application fees.  The field will be auto-populated with 
the application fee(s) total; the amount is dependent on how many Occupants you entered.  The 
field is modifiable if necessary.  

 
 
 
 
 
 
 
 
 
 
 

Application 
Charges 
(current 
step) 

 
 
 
 
 
 
 
 
 
 
 

To complete the Application Charges step 
 

1   The Charge Date field displays the current date. Change it if necessary. 
 

This date is used as the post date for the application charges. 
 

2   Review the charges and make changes, as necessary. 
 

3   If applicable, click the Select checkbox to add additional charges. 
 

4   Click Next. 
 

A message appears: Do you wish to post application charges? 
 

5   Click OK. 
 

The Application Status screen appears. The guest’s status changes from Prospect to Applied.
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On the dashboard, the Prospect Pipeline count is reduced by one and the Pending Applications 
count is increased by one. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

       Pending Applications Count 
 
 

Application Status 
 
 

In this section: 
 

Screening Applicants . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51 
Viewing the Guest’s Ledger  . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . .52 
Changing the Assigned Unit . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . 52 
Approving the Application . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53 
Executing the Lease. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53 
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Use the Application Status screen to process applications. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The screen has many functions. You can: 
 
!    View the guest’s ledger 

 
!    Change the assigned unit, if necessary 

 
!    Approve the application 

 
!    Print lease documents 

 
!    Execute the lease 

 
!    Cancel the application 

 
!    Reapply (if the application was cancelled) 

 
!    Deny the application 

 
!    Perform deposit accounting (if the application was cancelled or denied) 

 
!    Print move-out statement (if the application was cancelled or denied) 

 
!    Print denial letter (if application was denied. 
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Screening Applicants  
 
The screening company processes the application and makes a recommendation based on the 
results.  All information obtained by the screening company is confidential and may not be 
discussed with the resident. 
 
Recommendations 
 
There are several recommendations that can be made based on the criteria for residency. 
Based on the prospect’s qualifications, an applicant may be Approved and required to pay one 
of the following security deposit amounts: a security deposit equal to one-half of one month’s 
rent, a full month’s rent or two month’s rent. 
 
Prospects with limited rental history may require a co-signer, which would be an Approval With 
Co-Signer. In those cases, it is suggested that the co-signer’s application be submitted at the 
same time as the applicant’s application.  
 
Notification 
 
Direct contact with the applicant is required before disclosing the outcome of the screening.  
 
Approval 
 
Following notification of an APPROVAL, the applicant has 72-hours to place their required 
deposit of one-half to two month’s rent and to do one of the following: 
 

• Sign an Agreement to Execute a Rental Agreement, and pay the required deposit; -or- 
complete the entire Lease Packet and pay the required deposit. 

• Upon receipt of the deposit payment, provide the applicant with a Security Deposit 
Receipt. 

 
NOTE: If the Applicant should only sign an Agreement to Execute a Rental Agreement, 
provide them with a SAMPLE copy of the move-in paperwork to review prior to their move-in. 
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Viewing the Guest’s Ledger 
 

The guest’s ledger shows the charges to date for the guest. 
 
 

To view a guest’s ledger 
 

1   In the Application Status screen, click the Ledger button. The Resident Ledger screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   To print the ledger, right-click on the ledger and select Print. 
 

Changing the Assigned Unit 
 

If necessary, you can change the unit assigned to the guest at the application status step. 
 
 

To change the assigned unit 
 

1   Click the Assign Unit button. The Select Unit screen appears. ( This takes you back several steps in 
the process, to the Select Unit step.  

 

2   Select the appropriate unit. 
 

3   To return to the Application Status step, click the Application Status link (under Leasing Steps at 
the top of the screen). 
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Approving the Application 

 
 

To approve the application 
 

1   In the Application Status screen, click the Approve button. The Approval screen appears. 
 
 
 
 
 
 
 
 
 

2   The Date field displays today’s date. Change it if necessary. 
 

3   The Agent field displays the name of the agent who started the leasing workflow for this 
prospect. 

Change it if necessary. 
 

4   Click Save. A message appears: Do you wish to approve this prospect? 
 

5   Click OK. The Application Status screen displays a new line, showing that the application has 
been approved. 

 
 
 
 
 

Application approved line 
 
 
 

The buttons change: Execute Lease buttons appear. 
 
 

Executing the Lease 
 

After the lease documents have been signed, you can execute the lease. 
 
 

To execute the lease 
 

1   In the Application Status screen, click the Execute Lease button. The Lease Sign screen appears. 
 
 
 
 
 
 
 
 
 

2   The Date field displays today’s date. Change it if necessary. 
 

3   The Agent field displays the name of the agent who started the leasing workflow for this prospect. 
Change it if necessary. 

 
4   Click Save. A message appears: Do you wish to execute this lease? 

 
5   Click OK. 

 
The Resident screen appears. ( The guest has become a resident with a status of Future.) 
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Future status 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The dashboard count for Pending Applications is reduced by one. 
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Denying an Application 
 
 
Denial 
 
Responding to a denial must be done with care and sensitivity.  Remember that an applicant is 
denied due to a failure to meet the Criteria for Residency.  
 
Never tell an applicant that he or she has been denied. Instead, you may tell the applicant that his 
or her “application” has been denied. 
 
If the applicant questions the denial, direct him or her to the P.O . Box address of the screening 
company, located on the second page of the Criteria for Residency. 

 
To deny an application in Voyager 
 

1   In the Application Status screen, click the Deny button. The Denying screen appears. 
 
 
 
 
 
 
 
 
 
 

2   The Date field displays today’s date. Change it if necessary. 
 

3   The Agent field displays the name of the agent who started the leasing workflow for this 
prospect. 

Change it if necessary. 
 

4   Select a Reason. 
 

5   Click Save. A message appears: Do you wish to deny this application? 
 

6   Click OK. 
 

The application is denied and the guest’s status is changed to Denied. The Pending Applications 
count on the dashboard is decreased by one. 

 
 

Canceling an Application 
 
 

To cancel an application 
 

1   In the Application Status screen, click the Cancel button. The Canceling screen appears. 
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2   The Date field displays today’s date. Change it if necessary. 
 

3   The Agent field displays the name of the agent who started the leasing workflow for this 
prospect. 

Change it if necessary. 
 

4   Select a Reason. 
 

5   Click Save. A confirmation message appears asking you whether you want to cancel this applica- 
tion. 

 

6   Click OK. 
 
The Application Status screen re-appears. The screen features a Re-apply button in the place of the 
previous four buttons (Screening, Approve,  Deny, and Cancel).  The prospect’s status is changed to 
Canceled.  The cancelled prospect can later re-apply if he/she desires. 

 

The dashboard count for Pending Applications is reduced by one. 
 

Re-applying 
 

Use the following procedure to re-activate a cancelled application. 
 
 

To re-apply 
 

1   Locate the applicant record whose application was cancelled. For more information, see “Locating a 
Guest Record and Returning to the Leasing Workflow” on page 24. 

 
The record opens at the Application Status step. 

 
2   Click the Re-apply button. The Re-apply screen appears. 

 
 
 
 
 
 
 
 
 

3   The Date field displays today’s date. Change it if necessary. 
 

4   The Agent field displays the name of the agent who started the leasing workflow for this 
prospect. 

Change it if necessary. 
 

5   Click Save. A confirmation message appears asking you whether you want to process the re-
application. 

 

6   Click OK. The Application Status screen reloads with the Screening,  Approve,  Deny and 
Cancel buttons. 

 
The dashboard count for Pending Applications is increased by one. 

 
You might need to reselect a unit if the original unit has been rented out in the interim. Click the 
Select Unit link under Leasing Steps (at the top of the screen). 
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Performing Deposit Accounting 
 

Use the following procedure to perform deposit accounting for a cancelled or denied application. 
 
 

To perform deposit accounting 
 

1   In the Application Status screen, click the Dep Acctg button. The Cancel Future Move-In screen 
appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   Type the resident’s forwarding address. 
 

3   Select the appropriate charges (by clicking in the checkboxes in the Yes/No column). 
 

4   Type the amount of the charge in the Charge Amt. column. 
 

As you enter the charges, the Totals, Amount of Refund, and Amount Owed fields change 
depending on the charge amount and the deposit on hand. 

 
 

5   Select the Print Statement check box. 
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6   Click Post. The Move-Out Statement appears. Print the Move-Out Statement. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Adjust Deposit Accounting 
 

Use the following procedure to add additional charges or correct any other mistakes in deposit 
accounting for a cancelled or denied application. The function is available before the deposit check is 
processed. 

 
 

To adjust deposit accounting 
 

1   In the Application Status screen, click the Dep Acctg button. The Cancel Future Move-In screen 
appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click to 
select the 
charge code 

 
 
 
 
 
 
 
 
 
 
 

2   Select a charge code (by clicking the gray button to the right of the Chg. Code column). 
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3   Type the description of the charge in the Description column. 
 

4   Type the charge amount in the Charge Amt. column or a credit amount in the Credit column. 
 

5   Select the Print Statement check box. 
 

6   Click Post. The guest’s revised Move-Out Statement appears. Print the Move-Out Statement. 
 
 

Printing Move-Out Statements 
 

Use the following procedure to print a move-out statement for a canceled or denied application. 
 
 

To print a move-out statement 
 

1   In the Application Status screen, click the Move-Out Stmt. button. The Move-Out Statement 
appears. 

 
2   Print the Move-Out Statement.  

 

Other Procedures: Contact Records 
 

This procedure describes how to add a contact record to a guest record. 
 
 

To add a contact record 
 

1   In the Prospect Guest Card screen (any step), click the Contacts button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contacts button 
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The Contacts tab appears. 
 
 
 
 
 
 
 

2   Click the Add New Contact link. The Contact screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   Complete the following fields: 
 

 Type 
 

Select the appropriate type. (Contact types are set up at the property level.) 

Agent Select your own name (if you handled the guest; if not, select the appropriate 
agent). 

 Result Select the appropriate result. (Results are set up at the property level.) 

Date 
 

This field defaults to today’s date. Change it if necessary. 

Time Select the appropriate time, if appropriate. 

Notes Type notes, if applicable. 

 
4 

 
Click Save. 
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Resident Handling 
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Introduction to Resident Handling 

 
When an applicant is approved and scheduled for move-in (when the lease is executed), the applicant 
becomes a resident. In Voyager, the Resident screen displays a different status for each stage of 
the resident cycle. 
 
Actions—such as moving in and receiving a notice—change the resident’s status.  Each event is 
described in a separate section of this chapter. 
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Community Manager Dashboard 

 
 

In this section: 
 

Searching for Guests and Residents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63 
 
 

The Community Manager dashboard displays the community manager’s work for the day. The 
activities include performing tasks such as move-ins and move- outs, deposit accounting, 
renewing a lease, and reviewing alerts and exceptions that may affect property reports. 

 
Active property or property list 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Person Search tab 
 

The totals in the Resident Activity section (Move In, Move Out, and so on) are the number of 
residents scheduled for the activity. For example, the Move In total includes all residents 
scheduled to move in today and any residents who were scheduled to move in earlier but whose 
move has not been processed yet. 
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To search for a guest or resident 
 

1   Click the Person Search tab. 
 
 

Search 
results 

 
 
 
 
 
 
 
 
 
 
 
 
 

Name field Click the resident’s name to open the Resident screen 
 

2   In the Name field, type the first or last name of the person you want to look up. 
 

3   Click Search.  The right half of the screen displays the names of all guests or residents with 
that name. 

 

You can also search by unit number, phone number, Social Security number (Fed ID), or 
email address. 

 
Click the name link to open the Resident (or Guest) screen for that person. For a guest, 
Voyager displays the appropriate step in the applicant workflow. 

 
 
 

Move-In Procedures 
 
 

In this section: 
 

 

Changing a Future Resident’s Move-In Date . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . .  . . . . 64 
Canceling a Move-In . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . 65 
Changing the Unit Assigned to a Future Resident . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .… . 66 
Moving a Resident in to a Unit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68 
Preparing Move-In Paperwork……………………………………………...…... 69 

 
 

This section describes procedures related to move-in. The first three procedures describe actions 
that you might take before a resident moves in; the last procedure describes the actual move-in. 
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Changing a Future Resident’s Move-In Date 

 
 

To change a future resident’s move-in date 
 

1   On the dashboard, click the Move-In link. The bottom of the screen displays the move-ins sched- 
uled for today (and any unprocessed move-ins scheduled prior to today). 

 
Move-In link 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Adjust dates button 
 

2   Locate the appropriate resident and click the Adjust Dates button. The Adjust Move-In Dates 
screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 

Move-in date 
 
 
 
 
 
 

3   Type the new move-in date. If necessary, change the other dates on the screen. 
 

4   Click Post. 
 

Changing the move-in date to a later date causes the Move-In count on the dashboard to 
be decreased by one (if the new date is in the future). 
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Canceling a Move-In 

 
 

To cancel a move-in 
 

1   On the dashboard, click the Move-In link. The bottom of the screen displays the move-ins sched- 
uled for today (and any unprocessed move-ins scheduled prior to today). 

 
Move-In link 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cancel button 
 

2   Locate the appropriate resident and click the Cancel button. The Cancel Future Move-In 
screen appears.
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3   Complete the following fields: 

 
Cancel Date The cancel date. 

 

Reason Select the appropriate reason. (Reasons are set up at the property level.) 
 

Agent Select your own name (if you handled the cancelation; if not, select the appropriate 
agent). 

 
 

4   Click Submit. 
 

Canceling the move-in causes the Move-In count on the dashboard to be decreased by one. 
The resident’s status is changed to Canceled, and he/she is returned to the prospect workflow. 

 
Changing the Unit Assigned to a Future Resident 

 
 

To change the unit assigned to a future resident 
 

1   On the dashboard, click the Move-In link. The bottom of the screen displays the move-ins sched- 
uled for today (and any unprocessed move-ins scheduled prior to today). 

 
Move-In link 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click the resident’s name to open the Resident screen 
 

2   Locate the appropriate resident and click the resident’s name. The Resident screen appears. 
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3   On the Functions menu on the Resident screen, click the Assign Unit link. The Assign Unit screen 
appears. 

 
 
 
 
 
 
 
 
 
 
 

New Unit link 
 
 
 
 
 
 
 
 

4   Click the New Unit link. A list of available units appears. 
 

5   Select the new unit the future resident has chosen and click OK. 
 

6   Verify that lease dates and term are correct and make adjustments if necessary. 
 

7   Click Post. 
 

The resident’s status does not change. The unit status is updated accordingly: the old unit’s 
status changes from Rented to Unrented; the new unit’s status changes from Unrented to 
Rented. 
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Moving a Resident in to a Unit 

 
 

To move a resident in to a unit 
 

1   On the dashboard, click the Move-In link. The bottom of the screen displays the move-ins sched- 
uled for today (and any unprocessed move-ins scheduled prior to today). 

 
Move-In link 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Move-In button 
 

2   Locate the appropriate resident and click the Move-In button. The Move-In screen appears. 
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3   Verify that lease dates and term are correct and make adjustments if necessary. 
 

To determine the number of other leases that will expire near the end date of this lease, click the 
Lease expiration count link located to the right of the Lease-To Date field. 

 
 

4   Complete the move-in charges. 
 

The prorated rent is calculated by the system and cannot be changed. Also, any move-in charges 
specific to your community are included and charged at this time. Make sure to select any rentable 
items that the resident is leasing (for example, garage, parking, storage spaces, and so on). 

 

a   Include charges by selecting the checkbox in the Yes/No column. 
 

b   For rentable items (carport, garage, and so on), enter the code in the Code column. 
 

c    Specify the amount of a charge every month in the Lease Amt. field, or the amount of the 
charge at move-in in the Move-In Amt. field, if applicable. 

 
5   Click Post. 

 
The program changes the status of the resident to Current. The Move-In count on the dashboard is 
reduced by one. Any charges added for rentable items become recurring lease charges. 

 

Preparing the Move-In Paperwork 

 
The move in process is the final step before a new resident takes possession of an apartment. 
Specific guidelines should be followed to ensure that this process is executed properly and your 
new resident’s move-in goes smoothly!  
 
The Tenant Technologies program will print all required move-in forms and includes optional 
forms that you can select.  It is important that all move-in paperwork is read and signed by the 
resident prior to taking physical possession of their new apartment. Once you have compiled all the 
move-in paperwork, one copy of all move-in paperwork will go to the resident and one copy of all 
move-in paperwork will be kept in the resident’s onsite file. 
 
Prior to the move-in, highlight the signature and initial areas on all move-in paperwork for 
visibility. The Manager is the Designated Agent to sign the Rental Agreement. 

**Failure to collect the required signatures can lead to legal complications. 
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The following completed paperwork should be scanned into Voyager and saved in the Resident’s 
File.  It is important that each attachment is saved as a PDF document and the correct document 
type (listed below) is selected in Voyager.   

Form Save File As Attachment Type 
Rental Application Resident’s last name -Application-date.pdf  

 * example: Doe-Application-12-1-2014.pdf 
Application 

Recommendations from Screening 
Company 

Resident’s last name -Screening-date.pdf  
* example: Doe-Screening-12-1-2014.pdf 

Screening 

Rental Agreement Resident’s last name -Lease-date.pdf  
* example: Doe-Lease-12-1-2014.pdf 

Lease 

 
Other relevant addenda should also be explained as well: 

• Trespass Addendum to Rental Agreement (if applicable) – The purpose of this form is to 
assist in keeping drugs and other illegal activity off the property. 

• Lead-Based Paint Disclosure (if applicable) – This document discloses to all residents moving 
into apartment communities built prior to 1978 of lead-based paint hazards in compliance with 
the HUD and EPA federal laws. All residents who sign this disclosure, must also be provided with 
a copy of the EPA approved booklet, “Protect Your Family from Lead in Your Home”. 

• Unit Condition Report - The purpose of this document is to record the condition of the 
apartment at the time of move-in. The form must be signed by the Resident and the Managing 
Agent receiving the form. A copy of this report must be provided to the resident. 

• Utility Setup-Termination – This form is used for the purpose of providing the new resident 
with their address and a list of all utility companies. The new resident is responsible for setting 
up their required utilities and to provide the site management with the corresponding account 
number. This form must be returned at the time of move-in. 

• Pet Agreement (if applicable) – The Pet Agreement must be signed prior to the resident’s 
move-in. A photograph of the pet is suggested, and proof of renter’s insurance is required 
before the pet is allowed into the apartment. The Pet Agreement specifically states: before 
move-in of pet, resident shall provide Cambridge Real Estate Services with proof of insurance of 
a minimum of $100,000 liability to cover any damage or injury caused by said pet(s). The 
community should be named as an “additional interest” on the policy. Said proof shall be 
subject to re-verification at any time a declaration page is reissued. The resident shall notify 
Cambridge Real Estate Services of any lapse of insurance. 

• Mold and Mildew Addendum – The purpose of this document is to ensure all residents are 
aware of all mold and mildew hazards, prevention tips and clean-up procedures. 
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Lease Renewal Procedures 
 
 

In this section: 
 

Lease Renewal Process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71 
Canceling a Renewal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . 74 
Converting a Lease to Month-to-Month  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . 75 

 
 
 
Lease Renewal Process 

 
 

To start or continue the -lease renewal process 
 

1   On the dashboard, click the Expiring Leases link. The bottom of the screen displays a list of the 
leases that are expiring in the next 120 days (as well as leases that have already expired). 

 

2   Locate the appropriate resident and click the Renewal Workflow button. 
 

Expiring Leases link 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Click on the Renewal 
Workflow link. 
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The Lease Renewal screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
3   Complete the screen as follows: 

 
 

Lease From Date Enter the date the new lease will begin. 
 

Term Enter the lease term in months. 
 

Lease to Date Tab down from “Term” field and Voyager will calculate the lease to date based on 
the term of lease in previous field. Adjust manually if necessary.  

 
Old Rent Voyager will pull in the “old rent” based on the previous lease charge.  

 
New Rent Enter the new rent amount..   
  
 Note, the “New Rent” amount does not include rentable items or rub charges.  Those can 

be adjusted in the lease charge screen after the renewal has been processed. 
 

Increase Amount Voyager will calculate the increase amount automatically.  
 

 
4   Click Save.  
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5   The Resident Screen will appear to confirm that the lease renewal was processed successfully.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
6   Review the Scheduled Lease Renewal charges by selecting Data > Lease Charges.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
7   If necessary, make adjustments to Rub or Rentable Item charges in this screen and then click Save.  

 
 
On the Resident screen, the Lease From and Lease To dates are not immediately updated, so that 
the resident stays on the current lease until the new lease takes effect. On the appropriate date, the 
scheduled lease renewal is automatically converted to an active lease. 
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Canceling a Renewal 

 
 

To cancel a renewal 
 

1   On the dashboard, click the Scheduled Lease Renewals link. The bottom of the screen displays a 
list of the leases that are scheduled for renewal. 

 
Scheduled Lease 

Renewals 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cancel button 
 

2   Locate the appropriate resident and click the Cancel button. 
 

The resident is returned to the Expiring Leases count. The resident’s status remains Current. If 
appropriate, you can change the resident’s status to Month-to-Month  or Notice.  See the 
following procedures: 

 
"    “Converting a Lease to Month-to-Month” on page 84 

 
"    “Receiving a Notice to Vacate” on page 86 
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Converting a Lease to Month-to-Month 

 
 

To convert a lease to month-to-month 
 

1   On the dashboard, click the Expiring Leases link. The bottom of the screen displays a list of the 
leases that are expiring in the next 120 days (and leases that have already expired). 

 
Expiring Leases 

link 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

MTM button 
 

2   Locate the resident who is renewing and click the MTM button. The Lease Renewal screen 
appears. 
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Voyager fills in the fields in the screen. The Month to month date field defaults to the end of the lease 
plus one day. The Month to month premium and Charge code values are set up in Voyager it 
will automatically populate with the recurring premium rent charge. The amount in the New 
rent field is the market rent for that unit, it can be adjusted it needed. The Increase Amount 
field shows the difference between the New rent and the Old rent (but does not include the Month 
to month premium). 

 
3   Review the information on the screen and make changes if necessary.  

 

4   Click Save. The change to month-to-month is posted. 
 

The resident’s status remains Current. The resident’s history is updated to show that the lease has 
been changed to month to month. To view the resident history, click the Resident History link in the 
Data menu of the Resident screen. 
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Notice Procedures 
 
 

In this section: 
 

Receiving a Notice to Vacate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . ………….. . . . . . . .  77 
Eviction Process…………………………………………………………….   78 
Documenting an Eviction……………………………………………….…….   79 
Adjusting the Intended Move-Out Date for a Resident on Notice . . . . . . . . . . . .. . . . . . . . . . . ……... 80 
Canceling Notices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . …………… 81 
Canceling Evictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . …………….. 82 

 
 
 
Receiving a Notice to Vacate 

 
When a resident sends you a notice to vacate, you document it in Voyager. 

 
 

To receive a notice to vacate 
 

1   Using the Person Search tab on the dashboard, locate the appropriate resident and click the 
name link to open the Resident screen.  

 
 
 
 
 
 

Notice 
 
 

2   In the Resident screen, click Notice in the Functions menu. The Notice screen appears. 
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3   Complete the following fields: Termination Type, Notice Date, Move-Out Date, and Reason 
for Move-Out. 

 
4   If this is an early termination, select Post Early Termination Fee. 

 
This causes Voyager to post a charge to the resident ledger based on the property-level 
policy for early terminations. The policy is defined in the Property Control screen for the 
property. 
 

5   Click Save.  Voyager changes the status of the resident to Notice. 
 
 

Evictions 
 
Request for a Termination Letter 
 
Site Management Role: 

• Verbal warnings and mediation are strongly encouraged – Record any verbal mediation in 
Manager’s Log 

• Violation letter #1:      Friendly reminder 
• Violation letter # 2:    More assertive notice 
• Violation letter # 3:    Final attempt to resolve 
 

Site Employee Resource Center Role: 
• Final termination (Eviction) letters only 

 
Should I Request an Termination Letter? 

Consider the questions below prior to requesting an termination letter: 
• Is there a clear lease violation? 
• Have you personally intervened? 
• Have written warnings been served?  How many? 
• Has there been adequate time to remedy? 
• Does the punishment fit the violation? 

Requesting a Termination Letter 
To request a termination letter, complete a Request for Termination (Continuing Non-Compliance) 
form (#C059) from Tenant Technologies website and fax to the Site Employee Resource Center. 
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Delivering a Termination Letter 
Site Management Responsibilities: 

• Post / personally serve the violation letter on the same day that the letter is dated 
• Do not distribute internal paperwork (i.e. “Request for Termination”) 
• Complete proof of service; fax to the Site Employee Resource Center 
• Do not mail the violation Letter – it will be mailed from the Site Employee Resource Center 

Site Employee Resource Center Responsibilities: 
• Email letter to site for posting / personal service 
• Mail letter to resident via United States Postal Service 

 

Documenting an Eviction 
 

When you need to evict a resident from the property, you document the eviction in Voyager. 
Evictions work just like notices, except that the property usually determines the move-out date 
for an eviction— not the resident. 

 
 
To document an eviction:  

1   Using the Person Search tab on the dashboard, locate the appropriate resident and click the 
name link to open the Resident screen. For more information, see “Searching for Guests and 
Residents” on page 66. 

 
 
 
 
 
 
 
 
 

Evict 
 

2   In the Resident screen, click Notice in the Functions menu. The Notice screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   Complete the following fields: Evict Date, Move-Out Date, and Reason for Move-Out. 
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4   If you want to post a termination fee, select Post Early Termination Fee. 
 

This causes Voyager to post a charge to the resident ledger based on the property-level policy for 
early terminations. The policy is defined in the Property Control screen for the property. 

 
5   Click Save.  Voyager changes the status of the resident to Evict. 

 
 

Adjusting the Intended Move-Out Date for a Resident on Notice 
 
 

To adjust the intended move-out date for a resident on notice 
 

1   On the dashboard, in the Resident Activity section, click the On Notice link. The bottom part of 
the screen displays a list of the residents currently on notice. 

 
On Notice link 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Adjust Dates button 
 

2   Locate the appropriate resident. 
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3   Click the Adjust Dates button. The Notice screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Type the new Move-Out Date. 
 

5   Click Save. If the new move-out date is later than today, the Move-Out count is decreased by 
one. 

 
 

Canceling Notices 
 
 

To cancel a notice 
 

1   On the dashboard, in the Resident Activity section, select the On Notice link. The bottom 
part of the screen displays a list of the residents currently on notice. 

 
On Notice 

link 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cancel Notice 
button 

 
2   Locate the appropriate resident. 

 
3   Click the Cancel Notice button. 
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Voyager returns the resident’s status to Current. The On Notice count on the dashboard is reduced 
by one. If the resident’s lease will expire within 120 days (or has already expired), the Expiring 
Leases count is increased by one. 

 
If the unit has already been rented to someone else, the system will not let you cancel the notice 
until you assign another unit to the new resident. 

 
 
Canceling Evictions 

 
 

To cancel an eviction 
 

1   On the dashboard, in the Resident Activity section, select the On Notice link. The bottom 
part of the screen displays a list of the residents currently evicted. 

 
On Notice link 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cancel Evict 
button 

 
2   Locate the appropriate resident. 

 
3   Click the Cancel Evict button. 

 
Voyager returns the resident’s status to Current.  The On Notice count on the dashboard is 
reduced by one. If the resident’s lease will expire within 120 days (or has already expired), the 
Expiring Leases count is increased by one. 

 
If the unit has already been rented to someone else, the system will not let you cancel the eviction 
until you assign another unit to the new resident.
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Move-Out Procedures 
 
 

In this section: 
 

Moving Out a Resident . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88 
Canceling a Move-Out  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. .. . . . . . . . . . . . . . . . . . . . . . . . 85 
Deposit Accounting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .    85 
Adjust Deposit Accounting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .   88 

 
 
Moving Out a Resident 

 
 

To move a resident out of the property 
 

1   On the dashboard, in the Resident Activity section, click the Move-Out link. The bottom 
portion of the screen displays a list of the residents scheduled to move out. 

 
Move-Out link 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Move-Out button 
 

2   Locate the appropriate resident and click the Move-Out button. 
 

The resident’s status is changed to Past. 
 

On the dashboard, the Move-Out count is decreased by one, and the Deposit Accounting 
count is increased by one. 
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Canceling a Move-Out 
 

Use this procedure to reverse a move-out. This procedure is available before you per form deposit 
accounting. Once deposit accounting has been performed, there is no way to reverse a move-
out. 

 

 
To cancel a move-out 

 

1   On the dashboard, use the Person Search tab to find the appropriate resident. For more 
information, see “Searching for Guests and Residents” on page 64. 

 

2   Click the resident’s name. The Resident screen appears. 
 

3   On the Functions menu, select Cancel Move Out. 
 

Voyager returns the resident’s status and the unit’s status to Notice.  The On Notice count on 
the dashboard is increased by one. 

 
Deposit Accounting 

 
 

To perform deposit accounting 
 

1   On the dashboard, in the Resident Activity section, click the Deposit Accounting link. The bottom 
portion of the screen displays a list of the residents who have moved out and require deposit 
accounting. 

 
Move-Out link 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Deposit Acctg. button 
 

2   Locate the appropriate resident and click the Deposit Acctg. button. The Deposit Accounting 
screen appears. 



! YARDI!VOYAGER!RESIDENTIAL!PROCEDURES!GUIDE!
 

86 

 
3   This screen shows the resident’s deposit on hand and provides line items for charges that normally 

occur and line items you can complete manually. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Print Statement 
check box 

 
4   Type the resident’s forwarding address. 

 
5   Select the appropriate charges (by selecting in the checkboxes in the Yes/No column). 

 
6   Type the amount of the charge in the Charge Amt. column. 

 
As you enter the charges, the Totals, Amount of Refund, and Amount Owed fields change  
depending on the charge amount and the deposit on hand. 

 
 

7   Select the Print Statement check box. 
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8   Click Post. The Move-Out Statement appears. Print the Move-Out Statement. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Deposit Accounting count on the dashboard is decreased by one. The resident’s status is not 
changed: it remains Past. The Resident screen displays a note stating that deposit accounting has 
been posted. 
 

Processing Deposit Accounting Paperwork 

1. Print three copies of the Move Out Statement – one for the resident, one to be mailed to Site  
Employee Resource Center and one for site management records. 

2. Assemble all paperwork according to the Move-Out Envelope (available to order from B&B Print 
Source). Assemble all paperwork from the resident(s) file in the order listed on the move-out 
envelope. Do not seal the envelope. 

3. If the resident owes a balance, the Resident copy of the Move Out Statement is mailed directly 
from the site office to the Resident.  All other paperwork is placed in Move-Out Envelope and 
mailed to Site Employee Resource Center. 
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4. If the resident is due a refund, the Resident copy is placed in the envelope along with all other 
paperwork and mailed to Site Employee Resource Center.  The Site Employee Resource Center 
will then mail the Resident copy along with the refund check. 

5. Move-outs will result in either the resident owing the property a balance or the resident will be 
due a refund of their deposit.  Never both. 

 

Adjust Deposit Accounting 
 

The Adjust Deposit Accounting function allows you to add additional charges or correct any other 
mistakes in deposit accounting. The function is available before the deposit check is processed. 

 

 
To adjust deposit accounting 

 

1   On the dashboard, use the Person Search tab to find the appropriate resident. For more informa- 
tion, see “Searching for Guests and Residents” on page 64. 

 

2   Click the resident’s name. The Resident screen appears. 
 
 
 

Adjust Deposit Acctg. 
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3   On the Functions menu, select Adjust Deposit Acctg. The Adjust Deposit Accounting screen 

appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click to select the charge code 
 
 

Adjust Deposit Accounting appears on the Functions menu only if deposit accounting has 
already been performed for the resident. 

 
4   Select a charge code (by clicking the button to the right of the Chg. Code column). 

 
5   Type the description of the charge in the Description column. 

 
6   Type the charge amount in the Charge Amt. column or a credit amount in the Credit column. 

 
7   Select the Print Statement check box. 

 
8   Click Post. The resident’s revised Move-Out Statement appears. Print the Move-Out Statement. 



90! YARDI!VOYAGER!RESIDENTIAL!PROCEDURES!GUIDE!
 

 

Unit Transfer Procedures 
 

 
 

In this section: 
Entering Basic Transfer Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90 
Reviewing Resident Information . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92 
Reviewing Roommate Information . . . . . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93 
Reviewing Rentable Item Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94 
Reviewing and Posting the Transfer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . 95 

 
 

You can move a resident to another unit in the same property, or to another unit in a different 
property. You can transfer basic information about the resident, as well as information about 
roommates, rentable items, security deposits, and so on. 

 
 
 

The following graphic shows an overview of the unit transfer workflow. 
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Entering Basic Transfer Information 

 
 

To enter basic transfer information 
 

1   From the side menu, select Residents > Transfer Unit. The Transfer Unit filter appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   Complete the following fields: 
 
 

Property Select the property where the resident is currently located (optional). 
 

Unit Select the unit where the resident is currently located (optional). 
 

Resident Type or select the resident code of the resident who is transferring (required). 
 

To Property Type or select the property code to which the resident is transferring (required). 
 

To Unit Type or select the unit code to which the resident is transferring (required). 
 

Notice of Transfer Date Type or select the day the resident gives notice to transfer (this field defaults to the 
current day). 

The system sets this date as the default move-out and move-in dates for the 
resident. These dates can be changed later in the process. 

 
 

3   Click Submit. The Transfer Unit (Options) screen appears. 
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Reviewing Resident Information 

 
The top portion of the Transfer Unit (Options) screen summarizes resident and unit data for your ref- 
erence. To provide transfer options, enter the needed information in the bottom portion of the 
screen, in the Existing Lease Information,  New Lease Information,  and Custom Data sections. 
The Transfer Unit section lists the steps of the transfer process. 

 

 
To review resident information 

 

1   Review the Existing Lease Information section: 
 
 

Intended Move-Out Date    Select the date that the resident will move out of the unit. 
 

Notice of Transfer Defaults from the filter. 
 

Transfer Reason Select the reason for the unit transfer from the pull-down list of available options. 
 
 

2   Review the New Lease Information section: 
 
 

Lease From Date Type the date on which the resident’s lease is scheduled to start. 
 

Term Type the number of months in the lease term. The default value is the number 
of months specified at the time of property setup. 

 
Lease-To This field is completed by the system, based on the Lease From date and the 
Term. 

 
New Rent This field identifies the resident’s new rent amount. Type the new unit rent for the 

proposed lease. 
 

New Move-In Date                  Enter the date you expect the resident to move into the new unit. This date 
may be prior to the move-out date of the original resident so that the resident 
actually occupies both units at the same time. 

 
 

3   Review the Custom Data section. 
 

In the table, click the Transfer check box for data you want to transfer. Custom data can include 
items such as Abstract, Demographics, Options, and TI/Commission. 

 
4   Check Include Security Deposit Balance in Transfer if you want to include the security 

deposit balance as part of the transfer. Checking this option means that you want the resident’s 
balance to come over as part of the transfer as opposed to issuing a payable to the resident 
once they move out of the original unit. 

 

This check box will default to whatever is set up for this option on the Property Control screen. 
 

5   Click Next for the Roommates step. The Existing and Proposed Roommates section appears. 
 
 
 

Click to add a new roommate 
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Reviewing Roommate Information 
 
 

To review roommate information 
 

1   In the Existing and Proposed Roommates section, review the table of existing roommates and 
select any that will be part of the transfer. Clear the transfer check box if an existing roommate 
will not be transferring. 

 
If a roommate is not transferred, their name (and other information) is removed from the resident 
record. 

 
 
 

2   To add a new roommate, click the icon on the upper left of the table. The Add Roommates screen 
appears. 

 

 
 
 
 
 
 
 
 
 
 
 

3   Complete the Add Roommates screen, providing the roommate’s name, contact information, 
relationship to the lessee, and whether the roommate is also a lessee. 

 

4   Click Next for the Rentable Items step. The Existing and Proposed Rentable Items and Add 
Rentable Items sections appear. 
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Reviewing Rentable Item Information 

 
 

To review rentable item information 
 

1   In the Existing and Proposed Rentable Items section, select the rentable items that you want to 
transfer. 

 
Rentable items that are not transferred are released through the deposit accounting process 
when the transfer takes place. 

 
 

2   In the Add Rentable Items section, select any additional rentable items you want to include in the 
transfer. 

 
3   Click Next for the Review & Post step. New sections appear. 
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Reviewing and Posting the Transfer 
 
 

To review and post the transfer 
 

1   Review the Summary Information, Existing Lease Information, New Lease Information, and 
Other Details sections. 

 
2   Click Post Transfer. 

 
Once you click Post Transfer,  Voyager performs the following actions: 

 
"    The original resident record is given a new code. 

 
"    The original resident record is changed to a status of Notice. 

 
"    A new resident record is created and is given the original resident code. 

 
"    The new resident record receives a status of Future. 

 
"    The history tables are updated so that the occupancy reporting will be accurate. 

 
"    Depending on items chosen during the transfer unit process: 

 
#   Custom data is created on the new resident record. 

 
#   Rentable items lease charges have end dates added to them and are disassociated from 

the original resident. New lease charges for rentable items are created and associated with 
the new resident. 

 
#   The security deposit is transferred to the newly created resident record. 

 
 

Follow-Up 
 

When the date of the transfer arrives, you must perform: 
 
!    The standard move-out and deposit accounting (on the original resident record). 

 
!    The standard move-in (on the newly created resident record). 
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CHAPTER 4 
 
 
 
 

Unit Pricing 
 
 

In this chapter: 
 

Leasing Specials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  96 
 

 
 
 
 

This chapter contains procedures for raising market rents, creating rent incentives (specials), and 
using amenity-based pricing. 

 
 

Leasing Specials 
 
 

In this section: 
 

Setting Up Unit-Type Specials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .   97 
Using the Unit-Type Specials Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100 
Using the Available Units Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100 
Using the Unit Specials Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100 

 
 

Leasing specials are rent incentives that can be offered to a prospect as part of a lease. As a 
property manager, you can define leasing specials from the Community Manager Dashboard. 

 
You can define incentives for either a unit or a unit type. The leasing specials are on the hot 
sheet for the property and available for the leasing agent to offer as part of a lease. 
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The leasing specials for a unit type will not be available for a particular unit of that type if a leasing spe- 
cial is defined for that unit. This is useful for further refining the leasing specials you offer. For 
instance, you could have a leasing special for all your one-bedroom apartments, but then you 
could have a separate leasing special for one of the apartments that does not have as good a view as 
the others. 

 
Setting Up Unit-Type Specials 

 
 

To set up a unit-type special 
 

1   On the dashboard, click the Leasing Specials link. 
 

Leasing Specials link 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Leasing Specials screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add Special button 
 

When the screen opens, the Unit Type Statistics are displayed. Other tabs give you views of Unit- 
Type Specials,  Available Units, and Unit Specials. 

 

The Unit Type Statistics are displayed in table format so that you can review rental trends by unit 
types. The rental trends might give you some ideas about what kind of leasing specials would 
help rent vacant units and reduce turnover. 
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In the table, you can sort the rows of a column by clicking on a column heading. For example, to sort 
the unit types based on which are vacant and unrented, click on the Vacant Unrented column. 
You can sort upwards or downwards, as indicated by the small triangle that appears in the 
column heading. 

 

2   Click the Add Special button (for the appropriate unit type). The Leasing Specials screen appears. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   Complete the screen as follows: 
 
 

Property Displays the property. Change it if necessary. 
 

Lease Type Select whether you want the special to apply to New Move-In leases or Renewal 
leases. You can also select both, using CTRL + Click. 

 
Unit Type Displays the unit type. Change it if necessary. 

 
Description Type a brief description of the leasing special. The system displays this 

description when it lists the available specials to leasing agents and in hot sheets 
for the property. 

 
Amount Type the leasing special amount (the amount the rent will be reduced). 

 
Unit-Type Rent Displays the monthly rent defined for the unit type. 

 
Lease Term In the required field, type the shortest lease term (in months) to which the special 

can apply. In the optional field, type the longest lease term (in months) to which 
the special can apply. If the optional field is blank or zero, then there is no 
maximum. For example, if you type 12 in the required field and leave the optional 
field blank, the special can apply to a 12-month or longer lease. If you type 10 in 
the required field and 12 in the optional field, the special can apply to a 
10-month, 11-month, or 12-month lease. 

 
Charge Code Select the concession charge code. (Charge codes defined as concession codes 
on the 

Receivables Charge Code screen appear here.) 
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Taxable Check if you want to include the sales tax. 
 

Start Date Type the start date of the leasing special. 
 

Expiration Date Type the date (mmddyy) the leasing special expires. The lease must be 
executed on or before this date for the leasing special to be available. 

 
Modifiable Check to make the leasing special amount modifiable from the Move-In screen. 

 
Recurrence                  Select One-Time or Recurring. One-Time specifies  the special can apply as a one-

time event to a move-in amount or lease amount for a given month, but Recurring 
specifies the special can be applied to the lease amount across multiple months. 
If you select Recurring, the Proration and Recurrences fields appear. 

 
Starting Month Type the first month during the lease when the special applies. For example, if 

you want the special to apply starting on the second month of the lease, type 2. 
 

Proration Select None or Life of Lease. None specifies that the special is applied on a 
monthly basis for the months specified by Starting Month and Recurrences. Life of 
Lease specifies that the amount is distributed proportionally across the lease 
duration. For example, if the amount is 
$600 and the lease is 12 months, $50 is applied against the lease amount for 
each month. 

 
Recurrences Type the number of times a recurring special applies during the lease. For 

example, if Proration is None, Recurrences is 2, and the Amount is $600, $600 is 
applied against the first month and then $600 is applied against the second 
month. However, if Proration is Life of Lease, Recurrences is 2, and the Amount is 
$600, twice the Amount ($1,200) is distributed proportionally across the lease 
duration. 

 
Notes Type any reminders about the purpose of the leasing special. 

 
 

 
 
4   Click Save. 
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Using the Unit-Type Specials Tab 

 

 
 
 
 
 
 
 
 

The Unit-Type Specials tab displays all the specials defined for unit types for a specific property. For 
each special, there is an Edit button. 

 
To edit a unit type special, click the Edit button. 

 
To create a new unit-type special, click the New Record button  . 

 
 

Using the Available Units Tab 
 
 
 
 
 
 
 
 
 

The Available Units tab shows all the available units. The Days Vac. column shows how long each 
has been vacant. Use this tab to determine which units might need leasing specials. 

 

The Add Unit Special button opens the Specials screen, with that unit already filled in. 

The Add Unit Type Special button allows you to add a special for that Unit Type. 

 

Using the Unit Specials Tab 
 
 
 
 
 
 
 
 
 

The Unit Specials tab shows all the existing unit specials. There is an Edit button for each 

one. To create a new unit special, click the New Record button  . 



 

 
 
 
 
 
 
 
 
 

CHAPTER 5 
 
 
 
 

Rentable Items and Service Charges 
 
 

In this chapter: 
 
Assigning Rentable Items and Service Charges to Residents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  101 
Non-Resident Lessees and Rentable Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  106 

 

 
 

Rentable items are items that are rented to residents but are not connected to units—items such as 
garage spaces, carports, and storage lockers. Rentable items can also be rented to non-residents. 
For example, you might rent a parking space to someone who does not live at the property. 

 

Service charges are services that have no physical limit, and so can be offered to an unlimited 
number of residents—services such as cable internet or a pet fee. When you select a service 
charge during the either the leasing or renewal workflows, you can specify the quantity of the 
charge. For example, if there is a pet fee service charge and a future resident has two pets, you can 
add two instances of the service charge to the future resident’s guest card. 

 

This chapter contains the following procedures: 
 
!    Assigning rentable items to residents 

 
!    Releasing rentable items from residents 

 
!    Setting up non-resident lessees and assigning rentable items to them 
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Assigning Rentable Items and Service Charges to Residents 
 
 

In this section: 
 

Assigning Rentable Items and Service Charges to New Residents. . . . . . . . . .. . . .  . . . . . . . . . . . . . 102 
Assigning Rentable Items and Service Charges to Existing Residents . . . . . . . . . . . . . . . . . . . . . . . 104 
Releasing Rentable Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105 

 
 

Rentable items and service charges are assigned to residents in two ways: 
 
!    For a new resident, you assign rentable items and service charges in the leasing workflow and in 

the move-in procedure. 
 

!    For an existing resident, you assign rentable items and service charges by using a function that 
you can access from the side menu. 

 
Both methods are described on the following pages. 

 
 

Assigning Rentable Items and Service Charges to New Residents 
 

Rentable items and service charges appear in the Rental Options step of the leasing workflow, 
shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Reserve 
button 

 
 
 

Quantity (Qty.) field 
 
 

To add a service charge to the lease, type the number of instances of the charge in the Qty. field. 
 

To add a rentable item to a lease, click the Reserve button. The Rentable Item Reservation 
screen appears. 
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Select the Reserve checkbox in the row corresponding to any rentable items that you want to add. 
 
 
 
 
 
 

Reserve check box 
 

Click Save. The screen closes. Voyager calculates the charges and updates the Rentable Items and 
Options spreadsheet. (For complete information about the leasing workflow, see Chapter 2, “Leasing 
Workflow.” ) 

 
 
 
 
 
 
 
 

Rentable items and service charges appear again in the Move-In screen, in the Lease Charges table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Service charge 
 

 
Rentable items 
 
 
 

The rentable items and service charges selected for the resident (in the leasing step) have a check 
mark in the Select column. You can also add additional rentable items and service charges at this 
time. 
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If you want to select another rentable item, click the button to the right of the Code column. A pop-up 
appears, where you can select a specific rentable item (for example, a specific garage). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select a rentable item, then click OK. For complete information about move-in procedures, see 
Chapter 3, “Resident Handling.” 

 
 

Assigning Rentable Items and Service Charges to Existing Residents 
 

If the resident has already moved in, use the following procedure to add a rentable item or 
service charge to the lease. This procedure can also be used for non-resident lessees. 

 

 
To assign a rentable item to an existing resident 

 

1   From the side menu, select Residents > Rentable Items > Assign Rentable Item. The Assign 
Rentable Item filter appears. 

 
 
 
 
 
 
 
 
 

2   Complete these fields: 
 
 

Property Type a property code or select one from the list. 
 

Type Type a rentable item type or service charge—or select one from the list. 
 

Available Only Select Yes if you want to display only those rentable items that are available. 
Select No if you want all rentable items displayed. 

 

This field does not affect service charges 
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3   Click Submit. The Assign Rentable Items spreadsheet for the selected property appears. 
 
 
 
 
 
 
 
 
 

4   In the spreadsheet, locate the specific rentable item you want to assign to a resident (for example, 
Garage 18). If you selected a service charge on the Assign Rentable Item filter, only one row 
appears in the spreadsheet. 

 

5   Click the button to the right of the Lessee field. A pop-up appears. 
 

6   Select the appropriate resident (or non-resident lessee). 
 
 
 
 
 
 
 
 
 
 
 
 

7   Click OK. 
 

8   Complete the following fields: 
 
 

Lease From Type the beginning date of the lease (mmddyy). 
 

Lease To Type the end date of the lease. This field can be left blank if the end date is 
undetermined. 

 
Current Rent Accept the market rent amount associated with the rentable item, or change 

to another amount of your choosing. 
 
 

Note that the Code, Description, and Market Rent fields are read-only. 
 

9   Click Post. The system assigns the rentable item and creates a new lease charge. 
 
 

Releasing Rentable Items 
 

Rentable items are released from residents in two ways: 
 
!    For a departing resident, rentable items are automatically released when the lease ends. 

 
!    For a resident who wants to give up a rentable item before his/her lease ends, you can use a func- 

tion on the side menu to end the lease charge for the rentable item. 
 

This procedure does not apply to service charges. 
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To release a rentable item before the end of lease 

 

1   From the side menu, select Residents > Rentable Items > Release Rentable Item. The 
Release 

Rentable Item filter appears. 
 

 
 
 
 
 
 
 
 
 

2   Complete the following fields: 
 
 

Property Type a property code or select one from the list. 
 

Type Type a rentable item type or select one from the list. 
 

Resident Type a resident code or select one from the list. 
 
 

3   Click Submit.  The Rentable Items spreadsheet for the selected property appears. 
 
 
 
 
 

Release check box 
 
 
 

The spreadsheet contains only the rentable items that have been assigned to residents. 
 

4   Locate the item you want to release and select the Release check box. 
 

5   Click Post. The rentable item is released and the lease charge is terminated. 
 
 

Non-Resident Lessees and Rentable Items 
 
 

In this chapter: 
 

Adding a Non-Resident Lessee . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107 
Assigning Rentable Items to Non-Resident Lessees . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108 
Releasing Rentable Items From Non-Resident Lessees  . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108 

 
 

You can add non-resident lessees to the database, allowing you to rent rentable items to people who 
do not live at the property. For example, you could rent a garage space to a non-resident.  Contact 
your Yardi Support Team for help setting up rentable items that can be assigned to a non-resident 
lessee. 
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Adding a Non-Resident Lessee 

 
 

To add a non-resident lessee 
 

1   From the side menu, select Residents > Add Non-Resident Lessee. The Non-Resident Lessee fil- 
ter appears. 

 
 
 
 
 
 
 
 
 

2   Select a Property and click Submit. 
 

The Non-Resident Lessee screen appears. (Note: The screen only appears if you have defined at 
least one excluded unit for the property.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   Complete the following required fields: 
 
 

Unit Select a unit from the drop-down menu. The drop-down menu shows only 
units that are excluded and that are not Model, Down, Admin, or Wait List 
units. 

 
First Name Type the first name of the non-resident lessee. 

 
Last Name Type the last name of the non-resident lessee. 

 
Move In/Out Type the date the lessee will start renting the rentable items. 

 

When the non-resident lessee stops renting items and you perform the Move Out 
function, the 
Move Out date is completed by the system. 
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Lease From/To In the Lease From field, type the date the lessee will start renting the rentable items 
(the same date as the Move In date). In the To field, type the date the lessee expects 
to terminate the lease. 

 
 

4   Enter contact information (address, phone numbers, and so on). 
 

5   Click Save. The Resident screen appears; if needed, you can enter additional information. 
 

6   Click Save. The system creates a resident record for the non-resident lessee. 
 
 

Assigning Rentable Items to Non-Resident Lessees 
 

You assign rentable items to non-resident lessees the same way you would assign rentable items to 
existing residents. 

 
Releasing Rentable Items From Non-Resident Lessees 

 
You release rentable items from non-resident lessees the same way you would release rentable items 
from residents. 



 
 
 
 
 
 

CHAPTER 6 
 
 
 
 

Make Ready Functions 
 
 

In this chapter: 
 

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  109 
Make Ready Workflow ……………………………………. . . . . . . . . . . . . . . . . . . . . . . . . 110 

 
 

 
Introduction 

 

 
Make Ready Workflow  

 
When the resident’s status changes to Notice, the unit’s status changes to Not Ready and the 
Pending Make Ready count on the dashboard is increased by one. 

 
When the make ready work is complete, you can update the status of the unit from the 
Community Manager dashboard. 
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Performing the Make Ready Workflow  
 
 

To perform the make ready workflow (for properties without make ready details) 
 

1   On the dashboard, click the Pending Make Ready count. The Pending Make Ready table 
appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 

      
 

 
 
 
 
 
 
 
 
 

2   Click the Make Ready button to change the status of the unit to Rent Ready.  A warning 
message appears: Do you wish to make this unit ready? 

 

3   Click OK to continue. 
 

The unit is removed from the table. The Pending Make Ready count is decreased by one. The 
unit’s status changes to Rent Ready.

Pending Make Ready  
 

Pending Make Ready  
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Introduction to Charges 

 
You use Voyager to record charges in groups called batches. This chapter explains how to 
record charges, how to add a one-time charge, and how to reverse a charge.  

 

There are two ways to create batches of charges: detail and quick: 
 

• Use a detail batch to post individual charges. Detail batches comprise charge invoices, which in 
turn comprise multiple charges for an individual payer (resident). 

 

• Use a quick charge to quickly post a charge to a resident’s ledger from. Quick charge can be 
posted directly from the Resident Screen.  

 

Adding a charge to a batch does not update ledgers or financial records. Updating occurs when you 
post a charge batch. You can edit charges until they are posted. 
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Creating Detail Charge Batches 
 

If you are creating a batch with only one charge, or with many different charges, you should create 
detail batch. Otherwise, a quick charge batch is usually more efficient. Detail batches comprise 
charge invoices, which in turn comprise multiple charges for an individual payer. 

 

 
To create a detail charge batch 

 

1   Add the amounts of all the charges you will process. Write down the number. 
 

2   Count the charges you will process. Write down the number. 
 

3   On the Community Manager Dashboard, click the New Charge Batch link. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

New Charge Batch link 
 

The Batch Charge screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Complete the following fields: 
 
 

Total Declared Type the total dollar amount for charges in the batch.  If amount is unknown, you 
can enter an arbitrary amount (ex: $10,000) and edit once your batch is complete.  

 
Item Declared Type the quantity of charges in the batch. If amount is unknown, you can enter an 
arbitrary amount (ex: 100) and edit once your batch is complete. 
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5   Click Save. An empty table appears on the Charge Invoices tab below. 
 
 

New Record button (click to 
add a charge invoice to the 
batch) 

 
 

6   Click the New Record button. The Charge Invoice screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7   Complete the top part of the screen: 
 
 

Property Select the property associated with the charges. This helps you filter payers in the 
Charge To field. 

 
Unit Select the unit associated with the charges. This helps you filter payers in the 

Charge To field. 
 

Charge To Select the person who pays the charges. If you completed the Unit field, you can 
only select a person associated with that unit.  *If Charge To person is an 
applicant, future or past resident you will need to click on Charge To hyperlink 
and search for person(s) using the appropriate perimeters.  

 
Total Amount (You cannot edit this field; the value changes as you add charges on the Details 
table below.) 

 
Charge Date Type or select the date on which you want to post the charges. 

 
Post Month Type the month and year in which you want to post the charges. 

 
 

8   On the Details tab, complete a row for each charge that you want to post to the payer’s ledger: 
 
 

Charge Code Select or type the charge code, then press the TAB key to tab to the next field 
(Amount). When you do this, Voyager automatically completes the Description, 
Account, and A/R Account fields with the values associated with the charge code. 

 
Description  (You cannot edit this field; Voyager automatically completes it when you complete 

the Charge Code field. ) 
 

Amount Type the amount of the charge. 
 

Notes Type any notes about the charge, keep in mind these will appear on the 
Resident’s Ledger.  
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Account  (You cannot edit this field; Voyager automatically completes it when you complete 
the Charge Code field. ) 

 
A/R Account  (You cannot edit this field; Voyager automatically completes it when you 

complete the Charge Code field.  
 

Hold If you want to prevent Voyager from accepting payment for the charge, select this 
check box.  In most cases, this function would be used for a Housing charge.  

 
Another reason you may hold a charge is if the charge or payer is under 
investigation and there might be legal consequences for accepting the payment. 

 
9   Click Save. If there are more charges in the batch, a blank Charge Invoice screen appears. 
 
10 Complete each additional Charge Invoice screen that appears. When the total entered matches 

or exceeds the total declared, or the number of items entered matches the number of items 
declared, the Batch Charge screen appears. 

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 

The Declared and Entered fields must match before you can proceed. If they don’t, you can 
modify the amounts in the Declared fields by clicking the Edit button on the top of the screen, or 
edit each charge invoice by clicking the Edit button in the row corresponding to each invoice 
on the Charge Invoices tab. 

 
11 Click Report.  The Unposted Charge Batch report appears. Verify that the information is 
correct and close the window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12 On the Batch Charge screen, click Post. 
  

Declared and Entered fields 
should match 
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13 When asked to confirm that you want to post, click OK. Voyager posts the batch and displays 
confirmation 
 
 
 
 
  
Posting One-Time Charges or Quick Charge 
 
When you post a one-time charge, Voyager adds the charge to the resident’s ledger immediately. The 
charge does not repeat. 
 
To post a one-time charge to a resident’s ledger 
 
1 If not already open, open the resident record that you want to add a one-time charge to.  
 
2 On the Functions menu, click Charge. The Create Charge screen appears. 
 

 
 
3 Complete the screen. 
 
4 Click Submit. 
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Adding Charges to an Existing Batch 
 

You can add charges to any batch until you post the batch. This procedure explains how to add a 
charge using the Detail Batch screen. 

 
You can still add charges to batches that you were added using the Quick Charges screen, as posting 
quick batches creates a detail batch. 

 
 

To add a charge to an existing batch 
 

1   In the Community Manager Dashboard, click the Charges link. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Charges 
link 

 
A table of unposted charge batches appears below the dashboard. 

 
 
 
 
 

Batch # link 
 

2   Click the Batch # link for the batch to which you want to add charges. Batches created as 
detail batches and batches created as quick batches appear in the list; you can add charges to 
any batch using this procedure. The Batch Charge screen appears. 

 
 
 
 
 
 
 
 
 
 
 

3   Edit the Total Declared and Items Declared fields to factor in the new charges. For example, if you 
plan to add two $50 charges to a batch with 10 declared charges and a declared total of $500, edit 
the Total Declared field to $600 [($50 × 2) + $600] and the Items Declared field to 12 (10 + 2). 
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4   Click Save. 
 

5   Click Add. The Charge screen appears. 
 
 
 

Click the Batch # link if you 
need to return to the Batch 
Charge screen 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6   Complete the screen. 
 

If you do not complete the Account field, Voyager uses the account associated with the charge 
code. If you do not complete the A/R Account field, Voyager uses the account specified in the 
Receivable field in the Accounts & Options screen. 

 
 

7   Click Save. Each time you click Save, Voyager shows a new Charge screen until the Items Entered 
matches the Items Declared,  or the Total Entered matches or exceeds the Total Declared.  
Then it shows the Batch Charge screen. 

 
 
 
 
 

Updated Declared and 
Entered fields 

 
 
 

The Declared and Entered fields must match before you can proceed. If they don’t, you can 
modify the amounts in the Declared fields or click the Edit button to return to the Charge screen 
and make changes there. Click the Batch # link in the Charge screen any time you need to 
return to the Batch Charge screen. 
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8   Click Report. The Unposted Charge Batch report appears. Verify that the information is correct 

and close the window. 
 
 
 
 
 
 
 
 
 
 
 
 

9   In the Batch Charge screen, click Post. 
 

10 When asked to confirm that you want to post, click OK. Voyager posts the batch and displays confir- 
mation. 

 
 
 
 
 
 

Deleting Charge Invoices from a Batch 
 

You can delete a resident’s charge invoice from a charge batch any time before you post the batch. 
 
 

To delete a charge invoice from a batch 
 

1   From the side menu, select Charges > Edit/Post Detail Batch. The Charge Batch Filter appears. 
 
 
 
 
 
 
 
 
 
 
 

2   Complete the filter, as needed. You can search for both detail batches and quick batches (which 
become detail batches when you post them); you can add delete charges from any batch using 
this procedure. 

 

3   Click Find. Matching batches appear in a table on the Batches tab below. 
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4   Click the Edit button in the row corresponding to the batch from which you want to delete a charge 
invoice. The Batch Charge screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click Edit 
 

5   In the table on the Charge Invoices tab, click the Edit button in the row corresponding to the 
charge invoice that you want to delete. The Charge Invoice screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Click Delete 
 

6   Click Delete. A confirmation request appears: Are you sure you want to delete this item? 
 

7   Click OK. 
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Deleting a Charge Batch 
 

You can delete a charge batch any time before it is posted. 
 
 

To delete a charge batch 
 

1   In the Community Manager Dashboard, click the Charges link. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Charges 
link 

 
A table of unposted charge batches appears below the dashboard. 

 
 
 
 
 

Batch # link 
 

2   Click the Batch # link for the batch you want to delete. Batches created as detail batches and 
batches created as quick batches appear in the list; you can delete any batch using this 
procedure. The Batch Charge screen appears. 

 
 
 
 
 
 
 
 
 
 
 

3   Click Delete. A confirmation request appears: Are you sure you want to delete this batch? 
 

4   Click OK. A confirmation message appears: Your batch has been deleted. 
 

5   Click OK again. 
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Reversing Charges 
 

You can reverse tenant (resident) charges added by mistake. This procedure creates negative 
charges with zero-dollar receipts to tie the charges and negative charges together. 

 

 
To reverse charges 

 

1   From the side menu, select Charges > Reverse Charge.  The Reverse Charge filter appears. 
 
 
 
 
 

These fields locate the 
charges to be 
reversed. 
 

 
These fields determine how 

the reversal is 
recorded. 

 

 
 
 

2   Complete the filter and click Submit. 
 

Voyager uses entries in the Property through Charge No. fields to locate charges to be reversed. 
Entries in the Post Date through Reverse Notes fields apply to the charges to be reversed in 
the following step. 

 

The Reverse Charge screen appears. 
 
 
 
 
 
 
 
 
 

Select 
charges to 
reverse 

 

 
 

3   Select the charges you want to reverse and click Post. 
 

4   When asked to confirm that you want to post, click OK. Voyager displays confirmation that 
the charges have been reversed. 
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Posting Late Fees 
 

Each month on the 5th after entering any rents collected prior to the 4th, run the Post Late Fees 
function within Yardi by completing the following steps: 

 
1   Complete all rent collection and post any un-posted Receipt batch prior to Posting Late Fees.  
Remember any receipt dated after the 5th of the month will be considered late and assessed a late fee.  

2   From the left side menu, click Charges -> Post Late Fee. 

 

 
 
3  Leave the Tenant field  blank.  

4   Fill in your Late Fee Date as the day we want to show the charge (Ex: 2/5/2015) and the Cutoff Date 
as the last day to pay rent before the late fee (Ex: 2/4/2015).  
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5  Review the late fee charges before creating a batch by selecting Report Only and click submit, 
the report will generate.   

 
 

6  If this all looks correct, proceed with Posting the Late Fees by returning to the Late Fee filter screen 
(see step 4 above).    

7  Change the Report Only field to Create Batch and click Submit.  This will create a batch, which can 
still be edited and viewed to make sure everything is correct. 

8  To post this batch, choose Charges -> Edit/Post Detail Batch. 

 
 
*  Remember: You will only be able to see batches that you have created, and any other site personnel 
will not have access to the batches you create. Please coordinate with your site personnel in case 
reviewing is needed before posting.  

9  Once you have found your batch, click the Edit button to the far right. Review your charges before 
posting and if everything looks correct, click the Post button and all your late charges will be posted!  
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CHAPTER 8 
 
 
 
 

Receiving Payments 
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Introduction to Receiving Payments 
 

When you receive a rent payment, you use Voyager to record the payment and create a receipt. You 
enter receipts in groups called batches. This chapter explains how to record payments you 
receive. It also describes how to process zero-dollar receipts,  how to reapply a receipt and how to 
record an NSF check. 

 
 

Receiving Resident Payments 
 

The Create Detailed Batch function in Voyager creates a batch where you can enter payments for rent, 
charges, and deposits.  

 
 

To receive resident payments 
 

1   Count the payments you have received, to determine the quantity of receipts you will process. Write 
down the number of receipts.  

 
2   Add the amounts of all the payments you will process. Write down the number. 
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3   From the side menu, select Payments > Create Detailed Batch. The Batch Receipt screen 
appears. 
 

 
 

4   Complete the following fields and save: 
 

 
 
 
 

Total Declared Enter total sum of receipts to be entered.  Note, this can be edited before 
posting if needed.  

 
Items Declared Enter number of receipts to be entered.  Note, this can be edited before 

posting if needed. field. 
 

Description This field will auto-populate with the user name, date and time.  Do not edit.  
 

Notes Type note if needed. 
 

Deposit Date In most case this will be the date receipts were entered in Voyager or date deposited into 
bank. 

 
Deposit Memo Enter memo of deposit.  (Example: 12/2014 Rent Payments) 
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6   To add paym ents ,  click the icon (shown below) under the Receipt Tab.   

 
7   The Receipt window will open.  

 

 
 
Enter the following fields: 
 

 
Property Enter property name.   

 
Unit If the payment is from a current resident, enter the unit number. Once 

selected tab down and the payee will auto-populate.  
 

Payee If the payment is from a past, future, applicant or roommate, you can search for 
them by clicking the Payee Link and applying the appropriate filters.  

 
Total Amount Enter payment Amount 

 
Check Number Enter check, money order, or cashier’s check number.  If entering cash, type Cash into the 

field.  When enter a zero-dollar receipt, type 0$ into the field.  
 

Payment Method Select payment method from dropdown menu.  
 
Date Received Enter date received.  

 
Cash Acct Enter what account payment will be deposited into – Operating or Security.   

 



 127 
 
 
Notes To Remember When Entering Receipts  

• Verify the correct Cash Acct is selected.  Example Operating or Security.  

 
 

• Make sure the Total Amount matches the distributed.  
• Double check the payment was allocated correctly.  
• Make sure to Save changes.  

 
 

8   In the Notes field enter what charge the payment is being applied towards.  For example: 
“12/2014 Rent” or “10/2014 Late Fee”.  
 

 
  
9   Click Save. 
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10  Repeat steps until all of your receipts are entered for this batch. 
 

11 To Post the batch, click the hyperlink from the receipt window Unposted BatchXXXX.  This 
will take you back to the batch window.  Edit the Total Items Declared and Total 
Amount if needed and Save changes. Then click Post, once the batch has been successful 
posted a confirmation message on the top part of the screen.  

 
12.  Print a Deposit slip from Voyager, by clicking Deposit button from the batch screen.  Staple the 
bank receipt and the yellow carbon copy from your bank deposit slip together to be sent in at Month 
End.  
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Receiving Non-Resident Payments 
 

You must create a detail receipt batch to post payments for non-residents in Voyager. Because 
Voyager does not keep ledgers of non-resident payers, you must manually add each receipt. Each 
receipt can apply to multiple charges. 

 

 
To receive a non-resident payments 

 

1   Count the payments you have received, to determine the quantity of receipts you will process. 
Write down the number. 

 
2   Add the amounts of all the payments you will process. Write down the number. 

 
3   From the side menu, select Payments > Create Detail Batch. The Batch Receipt screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Complete the following fields: 
 
 

Total Type the total dollar amount for receipts in the batch. 
 

Item Count Type the quantity of receipts in the batch. 
 

Deposit Date Type or select today’s date. 
 
 

5   Click Save. An empty table appears on the Receipt tab below. 
 
 

New Record button (click to 
add a receipt to the batch) 

 
 

6   Click the New Record button. The Receipt screen appears. 
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7   In the Non-Person Payer field, type the full name of the payer, then press the TAB key. Some fields 
disappear. 

 

 
 

8   Complete the remaining fields on the top part of the screen: 
 
 

Property Select the property associated with the receipts. This helps you filter payers in the 
Charge To 

field. 
 

Total Amount Type the amount of the receipt. 
 

Check Number If the non-resident payer is paying using a check, type the check number in this 
field. 

 
Payment Method Select the appropriate payment method. 

 
Date Received Type or select today’s date. 

 
Post Month Type the month and year in which you want to post the receipt. 

 
Cash Acct. Select the cash account to which you want to post the receipt. 

 
 

9  In the spreadsheet on the Charges tab, complete a row corresponding to each charge to which you 
want to apply the receipt: 

 
 

Pay Type the amount of the charge for which the non-resident payer is paying. The 
receipt pays for the full amount of the charge. 

 
Charge Code Type or select the charge code for the charge. 

 
Account (Leave this field empty; Voyager automatically completes this field based on the 

charge code when you save the receipt.) 
 

The following graphic shows what a completed row should look like: 
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10 Click Save. If there are more receipts in the batch, a blank Receipt screen appears. 
 

11 Complete each additional Receipt screen that appears. When the total entered matches or exceeds 
the total declared, or the number of items entered matches the number of items declared, the 
Batch Receipt screen appears. 

 
 
 
 

Declared and 
Entered fields 
should match 

 
 
 
 
 
 
 
 
 
 

The Declared and Entered fields must match before you can proceed. If they don’t, you can 
modify the amounts in the Declared fields by clicking the Edit button on the top of the screen, or 
edit each receipt by clicking the Edit button in the row corresponding to each receipt on the 
Receipt tab. 

 

12 Click Report. The Unposted Charge Batch report appears. Verify that the information is correct 
and close the window. 

 
 
 
 
 
 
 
 
 
 
 
 

13 On the Batch Receipt screen, click Post. 
 

14 When asked to confirm that you want to post, click OK. Voyager posts the batch and displays 
confirmation. 
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16 Print a Deposit slip from Voyager, by clicking Deposit button from the batch screen.  

 
 
17 Staple the Ticker Tape, bank receipt, the carbon copy from the bank deposit slip to the Deposit 
printed from Voyager to be sent in at Month End.  

 



 133 
 
Processing Zero Dollar Receipts  

 
It is necessary to process a zero dollar receipt when you wish to apply a credit to a debit in Voyager.   
The Create Detailed Batch function in Voyager creates a batch where you can process Zero Dollar 
Receipts.   

 
 

To create a zero dollar receipt 
 

 
1   From the side menu, select Payments > Create Detailed Batch. The Batch Receipt screen 

appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  



134!! YARDI!VOYAGER!RESIDENTIAL!PROCEDURES!GUIDE!
 

 
4   Complete the following fields and save: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Total Declared Enter total sum of receipts to be entered.  Note, for Zero Dollar 
Receipts this amount will always be 0.  

 
Items Declared Enter number of receipts to be entered.  Note, this can be edited before 

posting if needed.  
 

Description This field will auto-populate with the user name, date and time. Add your 
Property Name. 

 
Notes Type note if needed. 

 
Deposit Date In most case this will be the date receipts were entered in Voyager or date deposited into 

bank. 
 
 

Deposit Memo Enter memo of deposit.  (Example: Adjustment to Pro-rate Charges) 
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6   C l ick  the icon (shown below) under the Receipt Tab.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7   The Receipt window will open.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter the following fields: 
 

 
Property Enter property name.   

 
Unit If the payment is from a current resident, enter the unit number. Once 

selected tab down and the payee will auto-populate.  
 

Payee If the payment is from a past, future, applicant or roommate, you can search for 
them by clicking the Payee Link and applying the appropriate filters.  

 
Total Amount Enter payment Amount ; for Zero Dollar Receipts the total should always be 0.  

 
Check Number When enter a zero-dollar receipt, type 0$ into the field.  

 
Payment Method Select Check. 
 
Date Received Enter date.  

 
Cash Acct Enter what account payment will be deposited into – Operating or Security.   

 
 



136!! YARDI!VOYAGER!RESIDENTIAL!PROCEDURES!GUIDE!
 

 
8   In the Notes field enter the purpose for the Zero Dollar Receipt  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
9   Click Save. 
 
 
 
9   Enter the debt and credited amount in the Charge fields.  The total should always come to $0 

when processing a Zero Dollar Receipt.  
 
10 Click  Save. 
 
11  Repeat steps until all of your receipts are entered for this batch. 

 
12 To Post the batch, click the hyperlink from the receipt window Unposted BatchXXXX.  This 

will take you back to the batch window.  Edit the Total Items Declared and Total 
Amount if needed and Save changes. Then click Post, once the batch has been successful 
posted a confirmation message on the top part of the screen.  
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Recording Not Sufficient Funds (NSF) Items 
 

Use the procedure for recording NSF items when a check is returned. This procedure reverses the 
receipt but also creates a journal entry for the bank’s returned check fee and adds your 
organization’s returned check fee charge to the appropriate resident ledger. 

 

 
To record an NSF item for a receipt 

 

1   From the side menu, select Payments > Find Payment Receipt.  The Receipt filter appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   Complete the filter with criteria appropriate to locate the receipt for which you want to record an 
NSF item and click Submit.  The Receipt screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NSF 
button 

 
3   Click the NSF button. 

 
Only receipts that have not been reconciled can be recorded as NSF. The NSF button appears on the 
Receipt screen only if the receipt can be recorded as NSF.   
 
Contact your Property Accountant if you need to record a reconciled receipt as NSF.  
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The NSF Receipt screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Complete the following fields: 
 
 

Reversal Date Type or select the current date. 
 

Post Month Type the month and year on the general ledger that you want the NSF reversal to 
affect. 

 
Bank Fee Type the bank fee for NSF items, as your organization requires. 

 
Bank Fee Account Select the account to which Voyager posts bank fees, as your organization 

requires. 
 

Payer Fee Type the payer fee for NSF items, as your organization requires. 
 

Payer Fee Chg Code Type or select the charge code for the payer fee, as your organization requires. 
 

Notes Type notes about the reversal, such as the reason.. You cannot leave this field 
empty. 

 
 

5   Click Save. When Voyager asks you to confirm that you want to NSF the receipt, click OK. Voyager 
creates a new receipt with negative amounts for each positive amount on the original receipt. Voy- 
ager references the control numbers of the related receipts in the Notes fields of both the original 
receipt and the NSF receipt. The following graphic shows the Notes field for an original receipt 
that has been recorded as NSF. 

 
 
 

Notes field 
 
 
 

If there was an amount in the Bank Fee field, Voyager creates a journal entry for that amount. If there 
was an amount in the Resident Fee field, Voyager adds the charge to the resident ledger. 
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Re-applying Receipts 

 
The Reapply feature allows you to modify a posted receipt, without changing the deposit record in 
bank reconciliation. You cannot change the amount, but you can apply the receipt to different 
charges or to a different resident.  
 

** Voyager will only allow you to re-apply a receipt that has not been reconciled.  Contact your Property Accountant if 
you need to re-apply a reconciled receipt. 

 

 
To re-apply a receipt 

 

1   From the side menu, select Payments > Find Payment Receipt. The Receipt filter appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   Complete the filter with criteria appropriate to locate the receipt that you want to re-apply and click 
Submit.  The Receipt screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Re-apply button 
 

3   Click the Re-apply button. A confirmation request appears: 
 

This function will reverse this receipt and require you to enter a new receipt. Are you sure you 
want to reapply this receipt? 
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4   Click OK. A new Receipt screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

5   Edit as needed. 
 

6   Click Save. A confirmation message appears: 
 

Receipt has been successfully re-applied. 
 

7   Click OK. A confirmation request appears: 
 

The web page you are viewing is trying to close the window. Do you want to close this window? 
 

8   Click Yes. 
 

Writing Off Charges 
 
Your Property Accountant will  perform Write Off charges in Voyager; the site manager will be 
asked to verify the Collection Report.  

Each month, resident move-out files are reviewed and those with a move-out occurring more than 
30 days prior and have a balance due to the property are reported to the site manager to determine 
whether the amount due will be written-off. 

The Collection Report 

Monthly, the Site Employee Resource Center reviews move-out files with a balance due that is left 
unpaid 30+ days. Not all properties will have collections for the month. The Site Employee Resource 
Center completes the Property Collections Report and emails the report to the site.  

The site manager reviews the amount and accuracy for each resident. The information included in 
the Property Collections Report are the Apartment #, Resident Name, Move-Out Date, Mailed 
Date, Total Due. The site manager then checks “Yes” or “No” to send the account to collections. 

• Any “No” response must be approved by the Property Supervisor. Payments plans are to 
be consistent with Cambridge policy — a maximum of three payment installments with the 
first installment equaling 50% of the debt. 

• If a payment has been made by the resident and the Amount Due is inconsistent with what 
the site manager reports, the site manager should indicate it on the report.  

• Before signing the Property Collections Report, be sure to verify the Amount Due and the 
amount to be written off in Voyager.  
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CHAPTER 9 
 
 
 
 

Processing Housing Vouchers 
(Tenant-Based Subsidy Receipts) 

 
This section explains how to create and post consolidated receipts for payments from tenant-based 
subsidy providers. 
 
 

In this chapter: 
 

Introduction to Tenant-Based Subsidy Receipts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  141 
Creating Consolidated Receipts for Tenant-Based Subsidy Payments . . . . . . . . . . . …….. . . . . . . . . . . .   143 
Posting Consolidated Receipts for Tenant Based Subsidies . . . . . . . . . . . . . . . . . . . . . . . . . . …… . . . . . .   146 
Reviewing Posted Subsidy Receipts in Resident Ledgers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ……..   148 
 
 

 

Introduction to Tenant-Based Subsidy Receipts  
 
A tenant-based subsidy provider’s payment may consist of one large amount to pay charges for 
many residents. In Voyager, a consolidated receipt distributes the total amount of a subsidy 
payment to pay subsidy charges for each resident in a property. When you create a consolidated 
receipt, Voyager allocates the subsidy payment toward each resident’s subsidy charges. 
 
In this section, you will learn how to complete and post a consolidated receipt for tenant-based 
subsidy payments. 
 

Voyager helps you to quickly complete Voyager screens. For fields that you can complete by typing, typing the first few 
characters automatically displays a selection list based on information that you previously used in that field. You can either 
select from the displayed list or complete the field by continuing to type. 
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To learn how to record a consolidated receipt for a subsidy overpayment, see “Overpaid Tenant-Based Subsidy Receipts” in 
Chapter 9. 

 
The following graphic shows the ledger for the resident used in the examples for this section. The 
ledger shows that resident’s rent charges have been paid. The outstanding balance is for the tenant-
based subsidy.  
 

  

Housing Charge 
Balance Due 
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Creating Consolidated Receipts for Tenant-Based Subsidy Payments 
 
Creating a consolidated subsidy receipt adds a record for the receipt. You can add or edit the 
information in a consolidated receipt until you create a batch for the receipt. 
 
To create a consolidated receipt for tenant-based subsidy payments 

1   From the side menu, select Payments > Consolidated Receipt > Add Consolidated Receipt 
w/ a Suspense Charge. The Create Consolidated Receipt filter appears. 

 

 
 
The Create Consolidated Receipt filter determines the subsidy charges and adjustments that appear 
on the Consolidated Receipt screen 

 
2   Complete the following fields: 

 
 

Property The property code selected on the Community Manager Dashboard screen appears 
 Type or select the property code, if needed.. 

 
Resident Select a specific resident or leave this field blank to bring up multiple tenants  

 
Charge Code Select Housing charge code – housing. 

 
Subsidy Suspense Select Housing Suspense charge code – hsngsusp 
Charge Code 

 
Hap Month Type the property’s subsidy month and year.  

 
Sort By Select the order in which you want the subsidy charges to appear, by unit or by resident. 
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3    Click Submit. The Consolidated Receipt screen appears. 

The Check Amount field in the top part of the screen is for the amount of the payment that you 
received from the subsidy provider. 0.00 initially appears. The Total Details field shows the total 
amount of subsidy charges for the residents listed in the table in the bottom part of the screen. 
The Difference field shows the difference between the payment amount and the total amount of 
the details. 
 
 
 

 
 
 

 

 

  

  

Total amount of housing payment 

Total amount of housing charges 

Difference between check and charges 

Total amount of Housing charges 
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4    Complete the following fields: 

 
 

Check Amount Enter amount of the provider’s payment. 
 

Description This field will pre-populate with the user/date/time – DO NOT erase.  Do add your 
property name.   

 
Check Number Enter the check number listed on the payment. 

 
Post Date Enter the date the payment was posted or deposited.  DD/MM/YYYY 

 
Post Month Enter the current post month. MM/YYYY  

 
 

 
 

 
 
5    Click Save. In order to post the payment, the difference between the check amount and total 

details must be 0.00 (zero).   You will need to make any necessary corrections prior to posting the 
payment receipt.  

 
6    Once the difference between the check amount and total details is zero, you are ready to post the 

receipt.  
 
7   Click Create Batch, this function will create the batch however you will since need to Post it.  
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Posting Consolidated Receipts for Housing (Tenant Based Subsidies) 

When you post a consolidated receipt, you will post the receipt to a batch. You can review and edit 
the transactions in the batch before you post the batch. The transactions will not affect the general 
ledger until you post the batch. 
 
To post a consolidated receipt 
 

1 From the side menu, select Payments > Consolidated Receipt > Review Consolidated 
Receipt. The Consolidated Receipt Review filter appears. 
 
2 Select the consolidated receipt that you created and saved and click Submit. The 
Consolidated Receipt screen appears. 
 
3 Complete the following fields: 

 
Check Number Type the number of the provider’s check 

 
Post Date Type the date that you are posting the receipt. 

 
Post Month Type the month and year that the posted receipt will affect the general ledger. 

 
 
4 Click Save. 
 
 
 

 
 
 
*** Remember you will need to Post or Delete unposted Consolidated Receipt Batches prior 
to opening a new Consolidated Receipt.   
 

5 Review the receipt again to ensure that it is as you expect. 
 
6 Click the Print button in the top part of the Consolidated Receipt screen and print a copy of the 
receipt. 
  

Check and post-date information 
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7  When you are ready to post the receipt, click the Create Batch button on the Consolidated 
Receipt screen. The Unposted Receipt Batch report screen appears. The batch number appears in 
the top part of the screen. The batch number is a link to the batch summary. 
 
 
 

 
 

8 Click the batch number. The Batch Receipt summary screen appears. 

 
9  Review the summary information to ensure that it is correct. If needed, you can edit or delete 

transactions in the batch or delete the entire batch. 
 
10  Click the Report button to review the batch report again. 

11  When you are ready to post the batch, click the Post button. A confirmation message appears. 
Click OK. Voyager posts the batch. 

 

 
 

Batch Number 
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Reviewing Posted Subsidy Receipts in Resident Ledgers 
 
You are now ready to review the ledgers of a resident included in the posted consolidated subsidy 
receipt. In this section, we will review the ledger and HAP ledger of Helen Woods, the first resident 
listed in the details of the posted receipt in our example. 
 
To review the ledger of a resident included in a consolidated receipt 
1 Open the Resident screen for a resident you wish to review.  
 
2 Open the resident’s ledger. The Resident Ledger screen appears. 
 
3 Review that resident’s ledger. In our example, the balance due is now 0.00 (zero). 

 
4 Click on the Chg/Rec number you wish to review.  

6 Click the link to review the charge. The charge is fully paid. 

Link to Housing Receipt  

Charge Status 
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CHAPTER10 
 
 
 
 

Overpaid Housing 
Or Tenant-Based Subsidy Receipts  

 
This section explains how to create and post consolidated receipts for payments from tenant-based 
subsidy providers when the check includes a subsidy overpayment. 
 
 

In this section: 
 
Introduction to Overpaid Tenant-Based Subsidy Receipts . . . . . . … . . .. . . . . . . . . . . .  . ….. . . .  .. . .  149 
Creating Consolidated Receipts for Overpaid Tenant-Based Subsidy Payments. . .. . . . . ... . .. . .. .  150 
Posting Consolidated Receipts for Subsidy Overpayments. . . . . . . . . . . ………….. . . . . . . . . .. . . . .  152 

 

 
Introduction to Overpaid Tenant-Based Subsidy Receipts  
 
Mid-month move-outs, subsidy terminations, or other issues can result in subsidy overpayments. 
Unlike rent that a resident pays before it is due, a subsidy overpayment is not a prepayment. After 
the provider reconciles its records, a subsidy provider will send a payment that is adjusted to 
recover the previously overpaid amount. 
 
When you create a consolidated receipt that includes a subsidy overpayment, Voyager 
automatically creates positive and negative charges posted to your subsidy suspense charge code. 
Voyager holds the negative charge in suspense, to apply the overpayment toward the provider’s 
later subsidy adjustment. 
 

 A subsidy provider may also occasionally underpay. When a subsidy provider underpays, Voyager holds the positive 
charge in suspense to apply to the provider’s later adjustment.. 

 

You can easily track subsidy overpayments. Unused overpaid amounts appear on each receipt until 
you use them to pay later charges. Outstanding amounts and balances appear on ledgers and 
financial statements. 
 
In this section, you will learn how to complete and post a consolidated receipt when a tenant-based 
subsidy provider overpays. You will process consolidated receipts for a subsidy overpayment and 
review a resident’s ledger and HAP ledger. 
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Creating Consolidated Receipts for Overpaid Tenant-Based Subsidy 
Payments 
 
After posting monthly charges for a property that includes residents with tenant-based subsidies, you 
receive the provider’s latest subsidy payment. In this example, the subsidy provider overpaid for one of 
the residents. You need to include the overpayment in the consolidated receipt. 
 
To create a consolidated receipt that includes a subsidy overpayment 
1 From the side menu, select Payments > Consolidated Receipt > Add Consolidated Receipt. The 
Create Consolidated Receipt filter appears. 
 
2 Complete the filter, selecting the property, tenant-based subsidy charge code (Housing) , subsidy 
suspense charge code (Housing Suspense), and subsidy month. 
 

 
 
3 Click Submit. The Consolidated Receipt screen appears. 
 

 
 
4 In the Check Amount field in the top part of the screen, type the amount of the subsidy payment. In 
this example, we will record a receipt for a payment of $100.00 more than the amount of the charges. 
Type the number that appears in the Total Details field, plus 100.00.  
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5 Click Save. The Difference field shows that the payment is for $100.00 more than the amount of the 
total charge details. 
 
You are ready assign the overpayment to the resident for whom it was paid. In our example, we will 
assign the overpayment Jeremy Desmond, the second resident listed in the details. 
 

You could assign the overpayment to any resident in the property. For example, if the overpayment applied to a past resident who had 
recently moved out, you would assign the overpayment to that resident. If the overpayment is split between two residents, you would 
apply the appropriate amount to each resident. 

 
 
 
 

 
 
 
 
  

Amount of provider’s payment 

Difference between payment and charges 

Select  button 
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6 On the first empty row in the details table, click the Select button and select the code of the resident 
for whom the overpayment applies.  
 
7 In the Payment field on that row, type the amount of the overpayment. 
 
8 Click Save. The difference between the payment amount and the totals detail is now 0.00 (zero). 
 
 
 
 
 

 
 
9 Print a copy of the receipt using the steps described in the previous lesson. You can use the printed 
copy to compare the receipt to your subsidy voucher. 
 
10 You have created and saved the consolidated receipt.  To Post the batch, click Create Batch and the 
unposted batch screen will appear.  Similar to the last chapter, click on the unposted batch number to 
be directed to the Batch Window where you can review and Post the batch.   

Amount of provider’s payment 

Difference between payment and charges Additional Payment 
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CHAPTER 11 
 
 
 
 

Paying Bills 
 
 

In this chapter: 
 

Introduction to Paying Bills. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . .  153 
Entering Vendor Invoices. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  153 
Entering Vendor Invoice as a Credit. . ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  . .  162 
Processing a Payable Batch (Thursdays)……………………………………………...163 
Quick Reference Guide to G/L Codes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . .  165 
 

 
 
 
 

Introduction to Paying Bills 
 

You use Voyager to record payable invoices. You enter invoices in batches. Payables in a batch do not 
update vendor ledgers or property financial records until your Property Accountant posts the 
batch.  

 
 

Entering Vendor Invoices 
 
 

To enter vendor invoices in a batch 
 

1   Count the invoices, to determine the quantity of invoices you will process. Write down the number. 
 

2   Add the amounts of all the invoices you will process. Write down the number. 
 

3   In the Community Manager Dashboard,  click the New Payable Batch link. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

New Payable Batch link 
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The Payable Batch screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Complete the following fields: 
 
 

Total Declared Type the total dollar amount for payable invoices in the batch. 
 

Item Declared Type the quantity of payable invoices in the batch. 
 

Description Change the description to “property  week begin – week end” (which should be a Friday 
thru Thursday).  Example:    Stone Creek 01/15 – 01/22.   

 
 
 
 

5   Click Save. An empty table appears on the Payables tab below. 
 
 

New Record button (click to 
add a payable invoice to the 
batch) 
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6   Click the New Record button. The Payable Invoice screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7   Type or select the payee code in the Payee field and press the TAB key. Voyager displays the 
vendor ’s name and address below the Payee field. 

 

8   Type the complete invoice number in the Invoice # field – for record keeping purposes it is 
important that it is not a partial invoice number.  

 
9   Type the total amount of the invoice in the Total Amount field. 

 
10 Change the dates in the Invoice Date, Post Month, and Due Date fields as appropriate. 
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11 If you want to split a payable across multiple properties: 
 

a   On the Details tab, click the Distribute button. 
 
 
 

Distribute button 
 

The Distribute Payable screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 

b   Complete the Distribute Payable screen. 
 

c   Click OK. Voyager adds one line for each property to the payable spreadsheet, splitting the 
amount of the payable evenly between the properties. 

 

13 Complete the spreadsheet on the bottom part of the Payable Invoice screen: 
 
 

Entity Type or select a property code for the first line item. 
 

Amount Type the dollar amount you are paying for the line item. The combined amount of 
all line items must match the amount in the Total Amount field before you can 
save this invoice. 

 
Account Type or select the G/L expense account. 

 
Notes Complete the notes field with a brief memo explaining the payable; example –

Carpet  Replacement #101. 
 
 

14 Click Save. If there are more invoices in the batch, a blank Payable Invoice screen appears. 
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15 Complete each additional Payable Invoice screen that appears. When the total entered matches or 

exceeds the total declared, or the number of items entered matches the number of items 
declared, the Batch Charge screen appears. 

 
 
 
 

Declared and 
Entered fields 
should match 

 

 
 
 
 
 
 
 
 
 

The Declared and Entered fields must match before you can proceed. If they don’t, you can modify 
the amounts in the Declared fields by clicking the Edit button on the top of the screen, or edit 
each payable invoice by clicking the Edit button in the row corresponding to each invoice on 
the Charge Invoices tab. 
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Entering Vendor Invoices as a Credit 

 
 
1   Click the New Record button. The Payable Invoice screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   Type or select the payee code in the Payee field and press the TAB key. Voyager displays the 
vendor’s name and address below the Payee field. 

 

3   Type the complete invoice number in the Invoice # field – for record keeping purposes it is 
important that it is not a partial invoice number.  
 
3   Change the Type to the complete invoice number in the Invoice # field – for record keeping purposes 
it is important that it is not a partial invoice number.  
 
4  Change the dates in the Invoice Date, Post Month, and Due Date fields as appropriate. 

 
5   Type the total amount of the invoice in the Total Amount field.  Often when you have a credit on a vendor 
invoice it appears on the invoice as a negative number, however you will NOT need to enter it as a negative number 
in Voyager.   
 
Instead, adjust the invoice Type to Credit, Voyager will know that the amount is a credit.  For questions regarding 
entering an invoice with a credit in Voyager, please consult with your Property Accountant.  
 
 

 
 
 
 

Change Type to Credit 
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6   Complete the spreadsheet on the bottom part of the Payable Invoice screen: 

 
 

Entity Type or select a property code for the first line item. 
 

Amount Type the dollar amount you are paying for the line item. The combined amount of 
all line items must match the amount in the Total Amount field before you can 
save this invoice. 

 
Account Type or select the G/L expense account. 

 
Notes Complete the notes field with a brief memo explaining the payable; example –

Returned Maintenance Supplies. 
 
 

7   Click Save. If there are more invoices in the batch, a blank Payable Invoice screen appears. 
 
8   Refer to the previous section on completing a Payable Batch.  

 
 

Processing Payable Batches (Every Thursday) 
 

1  Each Thursday after all your weekly payables have been entered, click Report. The Unposted 
Charge Batch report appears. Verify that the information is correct and click export to Excel.  
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2 Open the exported Excel document.  Highlight and erase columns G, H, J, and K. Then click Print.  
Make sure all other columns were included in the printed report.  

 
 

3  Collect all hard copy paper invoices included in the payable batch; keep in same order they were 
entered.    
 
4  Send the original copies of the invoices and the Printed excel batch report to the Site Employee 
Resource Center each Thursday.  Label the envelope attention to  “Payables” and include the dates 
for which the payables were entered; example – Payables 1/15 – 1/22.  
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CHAPTER 12 
 
 
 
 

Reports 
 
 

In this chapter: 
 

Residential Analytics Reports Overview.  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . .  166 
Monthly Posting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . .  . . . .  175 

 
 
 
 

 
 
Residential Analytics Reports Overview 
 
This section describes how to read the report references in this document. It also describes common 
fields on the Residential Reports filter. 
 
 
 

In this section: 
 

Residential Reports Filter Overview.  . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . .. .  167 
Aged Receivables  . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . .. . . . . . . .. . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  168 
Rent Roll w/ Lease Charges. . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . .. . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  170 
Security Deposit Activity . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . .. . . . .  . . . . . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . .  173 

  



 167 
Residential Reports Filter 
 
You can generate residential analytics reports from the Residential Reports screen. Use the filter on the 
top part of the screen to select the type of report that you want to generate and other parameters, such 
as the date range for which you want to generate the report. Many report types share the same filter 
fields. For more information, see below. 
 

 
 
 
Residential Reports Filter Reference 
 
 

Property You can select multiple properties or a property list. 
 

Date – to- Date range, comprised of a start date and an end date, that Voyager uses to search for 
data to display on the report. 

  
 On some reports, one of these two dates is disabled; this means that Voyager uses only 

the one date to search for data. For more information, see the section relevant to each 
report. 

 
 

 
Month/Year Month range, comprised of a start month with year and an end month with year, that 

Voyager uses to search for data to display on the report. 
  

On some reports, one of these two months is disabled; this means that Voyager uses only 
the one month to search for data. For more information, see the section relevant to each 
report. 

 
 

Summarize by On most reports, this is the record type that you want to fill the rows of the report. 
For example, if you summarize a report by Property, the report displays rows for 
each property. If you summarize a report by Unit Type, the report displays rows for 
each unit type at the properties.   

  
 On some reports, this field behaves differently. For more information, see the 

section relevant to each report. 
 

 
 

Show Graphs (Applies only to certain reports.) 
  
 Displays a graphical representation of the data in the report. 
 

 
Show Grids Separates rows and columns in the report with grid lines. 

 
 

Excel  Exports the report to a Microsoft Excel Binary File Format (.XLS) file.  
  

 
PDF Exports the report to a Portable Document Format (.PDF) file. 
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Aged Receivables Report 
 
Use the Aged Receivables report to view how much money residents owe as of a specified month. The 
report shows the following information as of a specified date: 

• Charges that are overdue by under 30 days, 31 to 60 days, 61 to 90 days, and over 90 days 

• Prepayments 

To generate the Aged Receivables report: 

1 From the side menu, select Reports > Property – Residential > Residential Analytics. The 
Residential Reports screen appears. 

2  In the Report Type field, select Aged Receivables Report.  

 

 

3  Complete the filters: 

 
 

Date – To  Date for which you want to view unit and resident statuses, and market rent amounts. 
  

 
Month/Year  Month in which transactions must be posted to be factored into the report. 
  

 
 

Summarize By Charge Code – summarizes transaction totals by charge code 
  
  Resident – summaries transaction totals by resident.  
   
 Property – summarizes transaction totals by property.  

  



 169 
Aged Receivables Report Example -  page 1 of 1 
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Rent Roll w/ Lease Charges Report 
 
Use the Rent Roll with Lease Charges report to evaluate monthly rent and deposits for your units. The 
report shows the following information for each unit as of a specified date: 

• Market rent 
• Lease charges 
• Deposits 
• Resident balances 

To generate the Rent Roll w/ Lease Charges report: 

1 From the side menu, select Reports > Property – Residential > Residential Analytics. The 
Residential Reports screen appears. 

2  In the Report Type field, select Rent Roll w/ Lease Charges.  

 

3  Complete the filters: 

 
 

Date – To -  Date for which you want to view unit and resident statuses, and market rent amounts.
  

 
 

Month/Year  Month in which transactions must be posted to be factored into the report.  
 

 
Summary  The report groups units by resident status—Current/Notice/Vacant Residents  and 

Future Residents/Applicants . 
 

 
 

4  Click Display.  

  



 171 
Rent Roll w/ Lease Charges Report Example -  page 1 of 2 
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Rent Roll w/ Lease Charges Report Example -  page 2 of 2 
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Security Deposit Activity Report 
 
Use the Security Deposit Activity report to track security deposits at properties in your portfolio. The 
report shows security deposit charges and receipts both prior and during the specified period. 

To generate the Security Deposit Activity report: 

1 From the side menu, select Reports > Property – Residential > Residential Analytics. The 
Residential Reports screen appears. 

2  In the Report Type field, select Security Deposit Activity.  

 

3  Complete the filters: 

 
 

Month/Year   Period during and before which you want the report to factor in security deposit receipts and 
 charges.  

 
 

Summarize By  Options are Resident  and Receipt/Charge  (one row per security deposit receipt or 
charge). 

 
 
 

4  Click Display.  
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Security Deposit Activity Report Example -  page 1 of 1 
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Monthly Posting Report 
 
Use the Monthly Posting report to review resident charges prior to the automatic posting that happens 
on the 25th of every month.  The report shows you monthly charges for a specified period. 

To generate the Monthly Posting report: 

1 From the side menu, select Charges > Monthly Posting. The Report screen appears. 

 

2  Complete the filters: 

 
 

Property   Enter the property name. 
 
 

mm/yy  Enter the Month and Year for which the charge will apply, in most cases this will be the 
month after your current account period.   

 
 

Report Only  Select Report Only.   
 

 
Variance?  Select Yes.   
 

 
 

4  Click Submit.  
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Monthly Posting Report Example -  page 1 of 1 
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CHAPTER 13 
 
 
 
 

End of Month Procedures  
 
 

In this chapter: 
 

Introduction to End of Month. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  177 
End of Month Schedule . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  177 
End of Month Checklist . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  178 

 
 
 
 

Introduction to End of Month 
 

End of Month is when the accounting month is closed and moved into the next month.  It is 
important that all the relevant dates are observed closely on the Operations Calendar and all 
the steps below are complete before the scheduled End of Month.  Once accounting has closed 
the month at your property you will not be able to post to that period,.  
 

End of Month Schedule – Refer to the Operations Calendar on the eExchange 
 
Complete your Month End Checklist by noon of the scheduled day.  Once the checklist has been 
reviewed and your paperwork has been sent to the Corporate Office, accounting will begin the 
process of completing the End of Month functions. Please do not post anything after this date 
until notified by Accounting that Yardi is ready for your next month’s postings.  
 
This process takes a few days, but feel free to reach out to your Property Accountant if you have 
any questions. This will not affect running your Monthly Posting Report. 
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Yardi End of Month Checklist 
!
Community:!________________________________!Month:!__________!Date______________!!
For assistance in completing this checklist, if you are in need of assistance, contact your property accountant.  

!
All!items!must%be!completed!in!the!order!that!they!are!listed.!Before!accounting!
month:end,!complete!the!following!steps:!!
!

YOUR!INITIALS!!

1!Print!the!Daily!Activity!report!and!review!the!following!sections:!! !
____________!!

a!Review!and!correct!any!resident!exceptions.!! !
____________!!

b!Review!month:to:month!(MTM)!residents.!Ensure!that!all!MTM!residents!
have!the!correct!MTM!charge.!!

!
!
____________!!

c!Review!on:notice!residents.!Ensure!that!all!move:outs!have!been!
completed!and!that!any!date!changes!have!been!entered.!!

!
!
____________!!

d!Ensure!that!all!move:ins!have!been!completed.!! !
____________!!

e!Ensure!that!all!deposit!accounting!has!been!performed.! !
____________!!

f!Ensure!that!all!lease!renewals!for!the!following!month!have!been!processed!
and!that!any!new!MTM!residents!have!been!converted!to!MTM.!!

!
!
____________!!

g!Ensure!that!all!guest!cards,!traffic,!applications,!and!rental!increases!have!
been!entered.!!

!
!
___________!!

2!Enter!all!invoices!for!the!current!month!and!complete!the!weekly!Thursday!
Payable!Processing!(refer!to!page!163).!!

!
____________!!

3!Post!all!receipts!applicable!to!the!current!month!for!any!resident.!! !

4!Post!all!open!charge!and!receipt!batches!for!the!current!month.!! !
____________!!

6!Review!the!following!reports!and!record!the!balances:!!
a!Aged!Receivables!!!

Total!Unpaid!Charges!!
Total!Prepayments!!!!!
!

b!Security!Deposit!Activity!!
Current!Dep.Billed!!
Current!Receipts!!
!

d!Rent!roll!!
e!Daily!Activity!!

Number!of!Exceptions!!
!
!

!
!
$_________!
$!_________!
!
$!_________!
!
$!_________!
!
!
!
!
!
!!___________!

7!Send!all!Bank!Deposit!Reports!(attached!to!corresponding!yellow!copy!of!bank!
deposit!slip!and!bank!receipt)!for!the!current!period!to!Corporate!Office.!!Address!
the!envelope!!“Cambridge%Real%Estates%Services%Attention%–%Yardi%Month%End”.!

!!____________!


